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Complete teacher’s manual for Open office impress 2 Class 1 

 Summaries 

 

 What is a ‘Standard toolbar’? 

‘Standard toolbar’ କଣ ? 

 Why we use ‘Standard toolbar’? 

ଆମମ ‘Standard toolbar’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to take a new page by using ‘Standard toolbar’? 

‘Standard toolbar’ କୁ ବୟବହାର କରି କିପରି ମଗାଟିଏ ନୂଆ ମପଜ ନିଆଯାଇଥାଏ ? 

 How to open any file with help of ‘Standard toolbar’? 

‘Standard toolbar’ ଦ୍ଵାରା କିପରି ମକୌଣସି ଫାଇ଱ କୁ ଓମପନ କରାଯାଏ ? 

 How to convert text document file into PDF file? 

ମଟକ୍ସଟ ଡକୁୟମମଣ୍ଟ ଫାଇ଱ କୁ କିପରି ପିଡ଼ିଏଫ ଫାଇ଱ କୁ ପରିବର୍ତ୍ତନ କରାଯାଏ ? 

 How to insert table with help of ‘Standard toolbar? 

 ‘Standard toolbar’ ସାହାଯୟ ମର ମଟବୁ଱ କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 Why we use ‘Fontwork’ option?  

ଆମମ ‘Fontwork’ ଅପ୍ଶନ କୁ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to hide and unhide ‘Standard toolbar’? 

‘Formatting bar’ କୁ hide ଏବଂ unhide କିପରି କରାଯାଏ ? 

 How to hide and unhide ‘Line and filling toolbar’?  

‘Line and filling toolbar’ କୁ hide ଏବଂ unhide କିପରି କରାଯାଏ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 
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1. To stop video time at 1 minute 22 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell how to type in a blank slide? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ମଗାଟିଏ blank 

slide କିପରି ଟାଇପ କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

2. To stop video time at 1 minute 45 seconds in VLC Media Player. 

 

Stop video here and ask how to insert a new slide and how many 

methods are there to insert a new slide’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ମଗାଟିଏ ନୂଆ slide କୁ କିପରି ଇନସଟତ କରାଯାଏ 

ଏବଂ ମଗାଟିଏ ନୂଆ slide କୁ ଇନସଟତ କରିବା ମକମ ାଟି ମାଧ୍ୟମ ଅଛି ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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3. To stop video time at 2 minute 50 seconds in VLC Media Player. 

 

Stop video here and ask which option is used for animation? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର Animation ପାଇ ିଁ ମକଉ ିଁ ଅପ୍ଶନ ର ବୟବହାର 

କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

4. To stop video time at 3 minute 01 seconds in VLC Media Player. 

 

Stop video here and ask what should we do to copy an object in 

different colors? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଅ଱ଗା ଅ଱ଗା color ମର ଥବିା object କୁ 

copy କରିବା ପାଇ ିଁ ଆମମ କଣ କରିବା ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

5. To stop video time at 3 minute 31 seconds in VLC Media Player. 

Stop video here and ask students to open ‘Impress file’. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ Impress file କୁ ଓମପନ କରିବା  

ପାଇ ିଁ କୁହ ।   

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

6. To stop video time at 5 minute 18 seconds in VLC Media Player. 

 

Stop video here and ask students to insert five slides and ask them to 

type something in the first slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ୫ ଟି slide ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

ମସମାନଙୁ୍କ ପ୍ରଥମ slide ମର କିଛି ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

7. To stop video time at 5 minute 39 seconds in VLC Media Player. 

 

Stop video here and ask students to draw any shape on 2 and 3 slides 

and also ask them to do formatting on these shapes and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଦି୍ଵ ୀୟ ଏବଂ  ୃ ୀୟ slide ମର ମଯମକୌଣସି 

shape  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ ମସମାନଙୁ୍କ ମସହ ିshape ଗଡୁିକମର formatting 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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8. To stop video time at 8 minutes 02 seconds in VLC Media Player. 

Stop video here and ask students to insert any object with help of 

‘Gallery’ option and in the 5th slide draw their name with help of 

‘Fontwork’ option and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Gallery’ ଅପ୍ଶନ ସାହାଯୟମର ମକୌଣସି 

object କୁ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ ପଞ୍ଚମ slide ମର ‘Fontwork’ ଅପ୍ଶନ 

ସାହାଯୟମର ମସମାନଙ୍କର ନାମ ମ଱ଖବିା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ 

। 

 

9. To stop video time at 22 minutes 01 seconds in VLC Media Player. 

Stop video here and ask the students to write their name with help of 

‘Fontwork’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

‘Fontwork’ ଅପ୍ଶନ ସାହାଯୟମର ମସମାନଙ୍କର ନାମ ମ଱ଖବିା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

10. To stop video time at 22 minutes 11 seconds in VLC Media 

Player. 

 

Stop video here and ask them if they remember what is ‘Standard 

toolbar’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ମମନରଖଛିନି୍ତ ‘Standard 

toolbar’ କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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11. To stop video time at 23 minutes 15 seconds in VLC Media 

Player. 

 

Stop video here and ask them, there are how many methods to take a 

new ‘Impress file’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ମସମାନଙୁ୍କ ପଚାର ମଗାଟିଏ ନୂଆ ‘Impress file’ ମନବା 

ପାଇ ିଁ ମକମ ାଟି ମାଧ୍ୟମ ଅଛି ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

12. To stop video time at 23 minutes 55 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know which shortcut command will you 

need to use to bring up a new slide. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ମଗାଟିଏ ନୂଆ slide 

ମନବା ପାଇ ିଁ ମକଉ ିଁ shortcut command  ୁମକୁ ବୟବହାର କରିବା ପାଇ ିଁ ମହବ ? 
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13. To stop video time at 25 minutes 18 seconds in VLC Media 

Player. 

Stop video here and ask students to take a new file by the first method 

as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ପ୍ରଥମ 

ମାଧ୍ୟମ ମର ମଗାଟିଏ ନୂଆ ଫାଇ଱ ଆଣବିା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

 

14. To stop video time at 26 minutes 57 seconds in VLC Media 

Player. 

Stop video here and ask students to take a new file by the third method 

as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  ୃ ୀୟ 

ମାଧ୍ୟମ ମର ମଗାଟିଏ ନୂଆ ଫାଇ଱ ଆଣବିା ପାଇ ିଁ କୁହ । 

Now just check whether they have completed the task or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ଏହା କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

15. To stop video time at 27 minutes 06 seconds in VLC Media 

Player. 

 

Stop video here and ask which shortcut command will be used to open 

‘Impress file’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ‘Impress file’ କୁ ଓମପନ କରିବା ପାଇ ିଁ 

shortcut command ର ବୟବହାର କରାଯାଏ ? 
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Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

16. To stop video time at 27 minutes 27 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can open ‘Impress file’ with help of 

‘Standard toolbar’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ‘Standard toolbar’ 

ସାହାଯୟମର ‘Impress file’ କୁ ଓମପନ କରିପାରିମବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

17. To stop video time at 28 minutes 47 seconds in VLC Media 

Player. 

Stop video here and ask students to close their current file and ask them 

to open impress file again as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

ମସମାନଙ୍କର ବର୍ତ୍ତମାନ ର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର impress file କୁ 

ପନୁବତାର ଓମପନ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

18. To stop video time at 32 minutes 28 seconds in VLC Media 

Player. 

Stop video here and ask students to use the ‘Send’ option as shown in 

the video and then play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Send’ 

ଅପ୍ଶନ ର ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

Note: - tell students there is no need to click on ‘Send’ button since 

internet connection is required to send an email. 

Note: - ଛାତ୍ରମାନଙୁ୍କ କୁହ ‘Send’ ବଟନ ଉପମର କ୍ିିକ୍ କରିବା ଆବଶୟକ ନାହି ିଁ ମଯମହ ୁ 

email ପଠାଇବା ପାଇ ିଁ internet connection ର ଆବଶୟକ ଅମଟ ।  

 

 

19. To stop video time at 32 minutes 53 seconds in VLC Media 

Player. 

 

Stop video here and ask, if they know why we use ‘Export as PDF’ option. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Export as 

PDF’ ଅପ୍ଶନ ର ବୟବହାର କାହି ିଁକି କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

20. To stop video time at 35 minutes 03 seconds in VLC Media 

Player. 

Stop video here and ask students to convert their file into pdf format as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

ମସମାନଙ୍କର ଫାଇ଱ କୁ pdf format କୁ ପରିବର୍ତ୍ତନ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ 

କୁ ପନୁବତାର ଚ଱ାଅ । 
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21. To stop video time at 35 minutes 45 seconds in VLC Media 

Player. 

Stop video here and check whether they have converted their file into 

PDF or not and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ମଚକ୍ କରିନିଅ ମସମାମନ ମସମାନଙ୍କର ଫାଇ଱ କୁ pdf 

format କୁ ପରିବର୍ତ୍ତନ କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

22. To stop video time at 37 minutes 06 seconds in VLC Media 

Player. 

Stop video here and ask students to see the video and understand how 

to use ‘Print directly’ option and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ କୁ ମଦଖବିା ପାଇ ିଁ କୁହ ଏବଂ ‘Print 

directly’ ଅପ୍ଶନ କୁ କିପରି ବୟବହାର କରାଯାଏ ବୁଝିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

Note: - printer machine should be connected with the system for 

printing so there is no need to click on the ‘Print directly option’. 

Note: - printing ପାଇ ିଁ printer machine ସଂମଯାଗ ମହବା ଆବଶୟକ ମ ଣ ୁ‘Print 

directly option’ ଅପ୍ଶନ ଉପମର କ୍ିିକ୍ କରିବା ଆବଶୟକ ନାହି ିଁ ।  

23. To stop video time at 37 minutes 36 seconds in VLC Media 

Player. 

 

Stop video here and ask students if they can use ‘Copy’, ‘Cut’ and ‘Paste’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପଚାର ଯଦି ମସମାମନ ‘Copy’, ‘Cut’ ଏବଂ  

‘Paste’ ଅପ୍ଶନ ର ବୟବହାର କରିପାରିମବ ? 
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Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

24. To stop video time at 38 minutes 22 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

25. To stop video time at 40 minutes 20 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ  । 

Now just check whether they have used copy, cut and paste option or 

not and then play the video. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Copy’, ‘Cut’ ଏବଂ  ‘Paste’ ଅପ୍ଶନ ର ବୟବହାର 

କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

26. To stop video time at 40 minutes 29 seconds in VLC Media 

Player. 

 

Stop video here and ask why we use ‘Format paintbrush’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଆମମ ‘Format paintbrush’ କାହି ିଁକି 

ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 
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ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

27. To stop video time at 41 minutes 28 seconds in VLC Media 

Player. 

Stop video here and ask students to draw an object as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

object  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

28. To stop video time at 42 minutes 42 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

29. To stop video time at 43 minutes 18 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Format paintbrush’ option or 

not and then play the video. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Format paintbrush’ ର ବୟବହାର କରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

30. To stop video time at 43 minutes 43 seconds in VLC Media 

Player. 
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Stop video here and ask students if they can use ‘Undo and Redo’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପଚାର ଯଦି ମସମାମନ ‘Undo ଏବଂ Redo’ 

ଅପ୍ଶନ ର ବୟବହାର କରିପାରିମବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

31. To stop video time at 45 minutes 07seconds in VLC Media 

Player. 

Stop video here and ask students to remove the object by using ‘Undo’ 

option as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Undo’ 

ଅପ୍ଶନ ର ବୟବହାର କରି object କୁ ହଟାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

32. To stop video time at 47 minutes 02 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Undo and Redo’ option or not 

and then play the video. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Undo ଏବଂ Redo’ ଅପ୍ଶନ କୁ ବୟବହାର କରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

33. To stop video time at 47 minutes 45 seconds in VLC Media 

Player. 

 



16 
 

Stop video here and ask students, if they know what we will do to give 

the link of another document on slide. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ସ୍ାିଇଡ ମର 

ଆଉ ମଗାଟିଏ document ର link ମଦବାପାଇ ିଁ ଆମମ କଣ କରିବୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

34. To stop video time at 50 minutes 48 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Hyperlink’ option or not and 

then play the video. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Hyperlink’ ଅପ୍ଶନ ର ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

35. To stop video time at 51 minutes 08 seconds in VLC Media 

Player. 

 

Stop video here and ask if they will be able to draw a table? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ମଗାଟିଏ table  ିଆରି 

କରିପାରିମବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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36. To stop video time at 52 minutes 56 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have drawn ‘Table ‘or not and then play the 

video. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Table ‘  ିଆରି କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

37. To stop video time at 53 minutes 56 seconds in VLC Media 

Player. 

 

Stop video here and ask what is ‘Display grid’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ‘Display grid’ ଅପ୍ଶନ କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

38. To stop video time at 54 minutes 47 seconds in VLC Media 

Player. 

Stop video here and ask students to show and hide ‘Grid lines’ as shown 

in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Grid 

lines’ କୁ ମଦଖାଇବା ପାଇ ିଁ ଏବଂ ଱ୁଚାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 
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39. To stop video time at 54 minutes 57 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can hide and unhide ‘Standard toolbar’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ‘Standard toolbar’ ଅପ୍ଶନ କୁ 

hide ଏବଂ  unhide କରିପାରିମବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

40. To stop video time at 58 minutes 01 seconds in VLC Media 

Player. 

Stop video here and ask students to show ‘Standard toolbar’ option as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Standard 

toolbar’ କୁ ମଦଖାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

41. To stop video time at 58 minutes 55 seconds in VLC Media 

Player. 

Stop video here and ask students to hide ‘Line and filling’ option as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Line and 

filling’ ଅପ୍ଶନ କୁ ଱ୁଚାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

42. To stop video time at 1 hrs 1 minutes 07 seconds in VLC Media 

Player. 

Stop video here and ask students to unhide ‘Line and filling’ option as 

shown in the video and then play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Line and 

filling’ ଅପ୍ଶନ କୁ ମଦଖାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

43. To stop video time at 01hrs 1 minutes 19 seconds in VLC 

Media Player. 

 

Stop video here and ask students to close their file and shout down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office impress 2 Class 2 

Summaries 

 

 What is a ‘Standard toolbar’? 

‘Standard toolbar’ କଣ ? 

 Why we use ‘Standard toolbar’? 

ଆମମ ‘Standard toolbar’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to take a new page by using ‘Standard toolbar’? 

‘Standard toolbar’ କୁ ବୟବହାର କରି କିପରି ମଗାଟିଏ ନୂଆ ମପଜ ନିଆଯାଇଥାଏ ? 

 How to open any file with help of ‘Standard toolbar’? 

‘Standard toolbar’ ଦ୍ଵାରା କିପରି ମକୌଣସି ଫାଇ଱ କୁ ଓମପନ କରାଯାଏ ? 

 How to convert text document file into PDF file? 

ମଟକ୍ସଟ ଡକୁୟମମଣ୍ଟ ଫାଇ଱ କୁ କିପରି ପିଡ଼ିଏଫ ଫାଇ଱ କୁ ପରିବର୍ତ୍ତନ କରାଯାଏ ? 

 How to insert table with help of ‘Standard toolbar? 

 ‘Standard toolbar’ ସାହାଯୟ ମର ମଟବୁ଱ କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 Why we use ‘Fontwork’ option?  

ଆମମ ‘Fontwork’ ଅପ୍ଶନ କୁ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to hide and unhide ‘Standard toolbar’? 

‘Formatting bar’ କୁ hide ଏବଂ unhide କିପରି କରାଯାଏ ? 

 How to hide and unhide ‘Line and filling toolbar’?  

‘Line and filling toolbar’ କୁ hide ଏବଂ unhide କିପରି କରାଯାଏ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 

 

 

 

 

 

 

 

 

 

 

44. To stop video time at 29 seconds in VLC Media Player. 
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Stop video here and ask why we ‘Standard toolbar? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଆମମ ‘Standard toolbar’ କଣ ପାଇ ିଁ 

ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

45. To stop video time at 1 minute 23 seconds in VLC Media 

Player. 

 

Stop video here and ask how to hide and show standard toolbar? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର standard toolbar କୁ କିପରି hide ଏବଂ  

show କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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46. To stop video time at 1 minute 55 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know what is ‘Display Grid’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Display Grid’ କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

47. To stop video time at 2 minute 21seconds in VLC Media Player. 

 

Stop video here and ask if they know why we use ‘Chart’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Chart’ କାହି ିଁକି 

ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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48. To stop video time at 2 minute 44 seconds in VLC Media 

Player. 

 

Stop video here and ask do you know what is ‘Print file directly’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ‘Print file directly’ କଣ  ୁମମ ଜାଣଛି କି ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

49. To stop video time at 3minute 02 seconds in VLC Media Player. 

 

Stop video here and ask students to open ‘Impress file’ and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ Impress file କୁ ଓମପନ କରିବା  

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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To stop video time at 03 minute 15 seconds in VLC Media Player. 

 

Stop video here and ask students to type the given paragraph on the 

first slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପ୍ରଥମ slide ମର ଦିଆଯାଇଥବିା ପାରାଗ୍ରାଫ 

କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

To stop video time at 3 minute 20 seconds in VLC Media Player. 

 

Stop video here and ask students to do formatting on the given 

paragraph as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ପାରାଗ୍ରାଫ 

ମର formatting କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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50. To stop video time at 3 minute 26 seconds in VLC Media 

Player. 

 

Stop video here and check whether they have finished the typing or not 

and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ମଚକ୍ କରିନିଅ ମସମାମନ ଟାଇପ କରିସାରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

51. To stop video time at 4 minute 30 seconds in VLC Media 

Player. 

Stop video here and ask students to change the ‘Font style’ as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Font 

style’ କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

52. To stop video time at 5 minute 07 seconds in VLC Media 

Player. 

Stop video here and ask students to change the font size of the 

paragraph as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

paragraph ର  ‘Font size’ କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

53. To stop video time at 5 minute 53 seconds in VLC Media 

Player. 

Stop video here and ask students to do ‘Bold’ and ‘Underline’ as shown 

in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Bold’ 

ଏବଂ ‘Underline’ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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54. To stop video time at 7 minute 28 seconds in VLC Media 

Player. 

Stop video here and ask students to change the ‘Font color’ as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Font 

color’ କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

55. To stop video time at 7 minute 40 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell there are how many methods to 

insert a new slide? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ମଗାଟିଏ ନୂଆ ସ୍ାିଇଡ 

କୁ ଇନସଟତ କରିବା ପାଇ ିଁ ମକମ ାଟି ମାଧ୍ୟମ ଅଛି ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

56. To stop video time at 10 minute 13 seconds in VLC Media 

Player. 

Stop video here and ask students to draw a rectangle and also ask to 

change the formatting of the rectangle and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଗାଟିଏ rectangle  ିଆରି କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ rectangle ର formatting କୁ ମଧ୍ୟ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 



27 
 

 

 

 

57. To stop video time at 8 minute 26 seconds in VLC Media 

Player. 

Stop video here and ask students to insert a new blank slide as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

ନୂଆ blank slide ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

58. To stop video time at 10 minute 55 seconds in VLC Media 

Player. 

Stop video here and ask students to do the formatting on the rectangle 

as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି rectangle 

ମର formatting କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

59. To stop video time at 11 minute 10 seconds in VLC Media 

Player. 

 

Stop video here and ask students to draw a table in slide and then play 

the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ slide ମର ମଗାଟିଏ table  ିଆରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

60. To stop video time at 13 minute 55 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

61. To stop video time at 17 minute 32 seconds in VLC Media 

Player. 

Stop video here and ask students to type the data in the table as shown 

in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଟବୁ଱ 

ମର data କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ।  

Now just check and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

62. To stop video time at 17 minute 37 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can change the design of the table? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ table ର design କୁ ମଚଞ୍ଜ 

କରିପାରିମବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

63. To stop video time at 18 minute 46 seconds in VLC Media 

Player. 

Stop video here and ask students to change the design of the table as 

shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି table ର 

design କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ 

Now just check and play the video again. 
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ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

64. To stop video time at 18 minute 59 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert a new slide and link another 

document with help of ‘Hyperlink’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଗାଟିଏ ନୂଆ slide ଇନସଟତ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ ‘Hyperlink’ ସାହାଯୟ ମର ଆଉ ମଗାଟିଏ document କୁ link କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

65. To stop video time at 19 minute 06 seconds in VLC Media 

Player. 

Stop video here and ask students to insert a new slide as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

ନୂଆ slide ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

66. To stop video time at 21 minute 50 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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67. To stop video time at 20 minute 59 seconds in VLC Media 

Player. 

Now just check whether they inserted ‘Hyperlink’ or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Hyperlink’ ଇନସଟତ କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

68. To stop video time at 21 minute 01 seconds in VLC Media 

Player. 

 

Stop video here and ask students to do ‘Copy’ and ‘Paste’ of slide 

number 3 and 4 and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ୩ ନମ୍ବର ଏବଂ ୪ ନମ୍ବର ସ୍ାିଇଡ କୁ ‘Copy’ 

ଏବଂ  ‘Paste’ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

69. To stop video time at 22 minutes 56 seconds in VLC Media 

Player. 

Stop video here and ask students to copy the slides as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ସ୍ାିଇଡ କୁ 

‘Copy’ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

70. To stop video time at 23 minutes 21 seconds in VLC Media 

Player. 

Stop video here and ask students to ‘Paste’ which they had copied. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Copy’ କରିଥବିା ସ୍ାିଇଡ କୁ ‘Paste’ କରିବା 

ପାଇ ିଁ କୁହ ।  

Now just check and play the video again. 
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ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

71. To stop video time at 23 minutes 42 seconds in VLC Media 

Player. 

 

Stop video here and ask students to do ‘Undo’ and ‘Redo’ and then play 

the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Undo’ ଏବଂ ‘Redo’ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

72. To stop video time at 24 minutes 27 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

73. To stop video time at 25 minutes 06 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘Undo’ and ‘Redo’ or not 

and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Undo’ ଏବଂ ‘Redo’ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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74. To stop video time at 25 minutes 36 seconds in VLC Media 

Player. 

 

Stop video here and ask students to hide some option of standard 

toolbars such as ‘New’, ‘Hyperlink’, ‘Display Grid’, ‘Copy and Paste’ and 

‘Undo and Redo’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ standard toolbar ର କିଛି ଅପ୍ଶନ କୁ 

଱ୁଚାଇବା ପାଇ ିଁ କୁହ ମଯପରିକି ‘New’, ‘Hyperlink’, ‘Display Grid’, ‘Copy ଏବଂ 

Paste’ ଏବଂ ‘Undo ଏବଂ Redo’ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

75. To stop video time at 25 minutes 10 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

76. To stop video time at 27 minutes 58  seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have hidden ‘these options’ or not and play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ମସହ ିଅପ୍ଶନ ଗଡୁିକୁ ଱ୁଚାଇ ସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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77. To stop video time at 28 minutes 08 seconds in VLC Media 

Player. 

 

Stop video here and ask students to save their file to the ‘Desktop’ and 

then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ‘Desktop’ ମର 

save କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

78. To stop video time at 29 minutes 05 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

79. To stop video time at 29 minutes 47 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have saved their file or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ମସମାନଙ୍କର ଫାଇ଱ କୁ save କରିସାରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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80. To stop video time at 29 minutes 55 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know there are how many methods are 

there to convert ‘PDF’ file? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଫାଇ଱ କୁ ‘PDF’ କୁ 

ପରିବର୍ତ୍ତନ କରିବା ପାଇ ିଁ ମକମ ାଟି ମାଧ୍ୟମ ଅଛି ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

81. To stop video time at 30 minutes 25 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

82. To stop video time at 32 minutes 38 seconds in VLC Media 

Player. 

Now just check whether they have converted their file into PDF or not 

and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ମସମାନଙ୍କର ଫାଇ଱ କୁ ‘PDF’ କୁ ପରିବର୍ତ୍ତନ 

କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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83. To stop video time at 32 minutes 33 seconds in VLC Media 

Player. 

 

Stop video here and ask students to close their file and shout down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office impress 2 Class 3 

Summaries 

 

 How to create a ‘Template’? 

ମଗାଟିଏ ‘Template’ କୁ କିପରି  ିଆରି କରାଯାଏ ? 

 Why we use ‘Properties’ option? 

ଆମମ ‘Properties’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to send any document to another user? 

ମକୌଣସି document କୁ ଅନୟ କାହା ପାଖକୁ କିପରି ପଠାଯାଏ ? 

 Why we use ‘Printer setting’ option? 

ଆମମ ‘Printer setting’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to insert a new slide? 

ମଗାଟିଏ ନୂଆ slide କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 Why we use ‘Preview in web browser’ option ?  

ଆମମ ‘Preview in web browser’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to hide and unhide ‘Standard toolbar’? 

‘Formatting bar’ କୁ କିପରି hide ଏବଂ unhide କରାଯାଏ ? 

 Why we use ‘Line and filling toolbar’?  

ଆମମ ‘Line and filling toolbar’ କାହି ିଁକି ବୟବହାର କରୁ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 

 

 

 

1. To stop video time at 14 seconds in VLC Media Player. 
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Stop video here and ask if they remember what they had learnt in the 

previous classes of this module. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ମମନରଖଛିନି୍ତ ଏହ ିmodule ର 

ପବୂତ କ୍ିାସ ମର ମସମାମନ କଣ ଶଖିଥିମି଱ ?  

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

2. To stop video time at 23 seconds in VLC Media Player. 

 

Stop video here and ask if they know which options can be kept in 

‘Standard toolbar’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Standard toolbar’ 

ମର ମକଉ ିଁ ଅପ୍ଶନ ଗଡୁିକୁ ରଖାଯାଇପାରିବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

3. To stop video time at 40 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell how to type in blank slide? 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ blank slide ମର 

କିପରି ଟାଇପ କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

4. To stop video time at 53 seconds in VLC Media Player. 

 

Stop video here and ask there are how many methods to insert a new 

slide? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ମଗାଟିଏ ନୂଆ ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ 

ମକମ ାଟି ମାଧ୍ୟମ ଅଛି ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

5. To stop video time at 1 minute 34 seconds in VLC Media Player. 

Stop video here and ask what will they do to make more than one image 

of the same picture. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ମଗାଟିଏ ଚିତ୍ର ରୁ ମସହପିରି ଅମନକ ଚିତ୍ର କରିବା 

ପାଇ ିଁ ମସମାମନ କଣ କରିମବ ?  

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

6. To stop video time at 1 minute 53 seconds in VLC Media Player. 
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Stop video here and ask students to open ‘Impress file’ and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ Impress file କୁ ଓମପନ କରିବା  

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

7. To stop video time at 2 minute 28 seconds in VLC Media Player. 

 

Stop video here and ask students to insert 3 slides and type the given 

paragraph on the first slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ 3 ଟି ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

ପ୍ରଥମ slide ମର ଦିଆଯାଇଥବିା ପାରାଗ୍ରାଫ କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

8. To stop video time at 2 minute 55 seconds in VLC Media Player. 
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Stop video here and ask students to insert any picture on the second 

slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଦି୍ଵ ୀୟ slide ମର ମଯମକୌଣସି ଚିତ୍ର କୁ 

ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

9. To stop video time at 4 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to insert any picture on the second 

slide as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଦି୍ଵ ୀୟ 

slide ମର ମଯମକୌଣସି ଚିତ୍ର କୁ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

 

10. To stop video time at 5 minute 45 seconds in VLC Media 

Player. 

Stop video here and ask students to draw a shape and also ask to do 

formatting in the drawing as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

shape  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ ମସହ ିଚିତ୍ର ମର formatting ମଧ୍ୟ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

11. To stop video time at 6 minute 01 seconds in VLC Media 

Player. 

 

Stop video here and tell students now they will learn about ‘Wizard’ 

option and then play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ କୁହ ବର୍ତ୍ତମାନ ମସମାମନ ‘Wizard’ ଅପ୍ଶନ 

ବିଷୟମର ଶଖିମିବ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

12. To stop video time at 6 minute 39 seconds in VLC Media 

Player. 

Stop video here and ask students to click on ‘File’ menu and then click 

‘Wizard’ option and then select ‘Letter’ option as shown in the video and 

then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ  ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Wizard’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ‘Letter’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

13. To stop video time at 7 minute 16 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

14. To stop video time at 8 minute 24 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

15. To stop video time at 9 minute 39 seconds in VLC Media 

Player. 

Now check whether they have created ‘Letter’ format or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Letter’ format  ିଆରି କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

16. To stop video time at 9 minute 51 seconds in VLC Media 

Player. 
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Stop video here and tell students to click on ‘File’ menu and then click 

‘Wizard’ option and then select ‘Fax’ option as shown in the video and 

then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ  ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Wizard’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ‘Fax’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

17. To stop video time at 10 minute 18 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

18. To stop video time at 11 minute 05 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the next option as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ପରବର୍ତ୍ତୀ 

ଅପ୍ଶନ କୁ କ୍ିିକ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

19. To stop video time at 10 minute 40 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the next option as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ପରବର୍ତ୍ତୀ 

ଅପ୍ଶନ କୁ କ୍ିିକ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

20. To stop video time at 11 minute 45 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Finish’ button and then 

save the template as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Finish’ 

ବଟନ କୁ କ୍ିିକ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର template କୁ save କରିବା ପାଇ ିଁ କୁହ । 
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Just check whether they have created ‘Fax’ format or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Fax’ format  ିଆରି କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

21. To stop video time at 12 minute 23 seconds in VLC Media 

Player. 

Stop video here and tell students to use the presentation option as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

presentation ଅପ୍ଶନ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

22. To stop video time at 13 minute 33 seconds in VLC Media 

Player. 

Stop video here and tell students to use the ‘Web page’ option as shown 

in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Web 

page’ ଅପ୍ଶନ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

23. To stop video time at 13 minute 48 seconds in VLC Media 

Player. 

Stop video here and tell students to click on ‘File’ menu and then click 

‘Wizard’ option and then select ‘Document converter’ option as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ  ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Wizard’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ‘Document converter’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

24. To stop video time at 14 minute 53 seconds in VLC Media 

Player. 

Stop video here and ask students to use the ‘Document converter’ 

option as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

‘Document converter’ ଅପ୍ଶନ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

Now just check whether they have used ‘Wizard’ option or not and play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Wizard’  ଅପ୍ଶନ କୁ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

25. To stop video time at 15 minute 09 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Send’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Send’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

26. To stop video time at 16 minute 57 seconds in VLC Media 

Player. 

Stop video here and ask students to click on ‘File’ menu and then click 

‘Document as Email’ option as shown in the video and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ  ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ  ଏବଂ  ାପମର ‘Document as Email’ ଅପ୍ଶନ କୁ କିି୍କ୍ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

27. To stop video time at 18 minute 04 seconds in VLC Media 

Player. 
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Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

Note: - tell students there is no need to click on ‘Send’ button since 

internet connection is required to send an email. 

Note: - ଛାତ୍ରମାନଙୁ୍କ କୁହ ‘Send’ ବଟନ ଉପମର କ୍ିିକ୍ କରିବା ଆବଶୟକ ନାହି ିଁ ମଯମହ ୁ 

email ପଠାଇବା ପାଇ ିଁ internet connection ଆବଶୟକ ।  

28. To stop video time at 18 minute 25 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know what happens with ‘Properties’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Properties’ ଅପ୍ଶନ 

ଦ୍ଵାରା କଣ ମହାଇଥାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

29. To stop video time at 19 minute 30 seconds in VLC Media 

Player. 

Stop video here and ask students to click on ‘File’ menu and then click 

‘Properties’ option as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ  ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Properties’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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30. To stop video time at 21 minute 21 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

31. To stop video time at 22 minute 34 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

32. To stop video time at 22 minute 44 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell what happens with ‘Printer 

setting’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ‘Printer setting’ 

ଦ୍ଵାରା କଣ ମହାଇଥାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

33. To stop video time at 23 minute 50 seconds in VLC Media 

Player. 
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Stop video here and ask students to click on ‘File’ menu and then click 

‘Printer setting’ option as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ  ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Printer setting’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

34. To stop video time at 25 minute 50 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

35. To stop video time at 26 minute 40 seconds in VLC Media 

Player. 

Stop video here and ask students to check out the ‘Printing shortcut’ 

option as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Printing 

shortcut’ ଅପ୍ଶନ କୁ check କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

36. To stop video time at 28 minute 24 seconds in VLC Media 

Player. 

Stop video here and ask students to use ‘Paper quality and Effects’ as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Paper 

quality and Effects’ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

37. To stop video time at 29 minute 48 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 
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Now just check whether they have used the ‘Printer setting’ option or 

not and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Printer setting’ ଅପ୍ଶନ କୁ ବୟବହାର କରିସାରିଛନି୍ତ 

କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

38. To stop video time at 29 minute 57 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Template’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Template’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

39. To stop video time at 31 minute 05 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘File’ menu and then 

select ‘Template’ option and also ask to save the document as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Template’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ document କୁ ମଧ୍ୟ save କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

40. To stop video time at 32 minute 57 seconds in VLC Media 

Player. 

Stop video here and ask students to use ‘Export the document’ as shown 

in the video and then play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Export 

the document’ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର  

ଚ଱ାଅ । 

41. To stop video time at 33 minute 25 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have created the ‘Template’ or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Template’  ିଆରି କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

42. To stop video time at 33 minute 26 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Preview in Browser’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Preview in 

Browser’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

43. To stop video time at 35 minute 40 seconds in VLC Media 

Player. 

Stop video here and ask students to use ‘Preview in web browser’ option 

as shown in video and then play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Preview 

in web browser’ ଅପ୍ଶନ ର ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

44. To stop video time at 35 minute 50 seconds in VLC Media 

Player. 

 

Stop video here and ask students to close their file and shut down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office impress 2 Class 4 

Class 4 Summaries 

 

 How to create a ‘Template’? 

ମଗାଟିଏ ‘Template’ କୁ କିପରି  ିଆରି କରାଯାଏ ? 

 Why we use ‘Properties’ option? 

ଆମମ ‘Properties’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to send any document to another user? 

ମକୌଣସି document କୁ ଅନୟ କାହା ପାଖକୁ କିପରି ପଠାଯାଏ ? 

 Why we use ‘Printer setting’ option? 

ଆମମ ‘Printer setting’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to insert a new slide? 

ମଗାଟିଏ ନୂଆ slide କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 Why we use ‘Preview in web browser’ option ?  

ଆମମ ‘Preview in web browser’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to hide and unhide ‘Standard toolbar’? 

‘Formatting bar’ କୁ କିପରି hide ଏବଂ unhide କରାଯାଏ ? 

 Why we use ‘Line and filling toolbar’?  

ଆମମ ‘Line and filling toolbar’ କାହି ିଁକି ବୟବହାର କରୁ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 

 

45. To stop video time at 38 seconds in VLC Media Player. 
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Stop video here and ask if they know what will they do for seeing slides 

on the web browser? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ web browser ମର 

ସ୍ାିଇଡ ଗଡୁିକୁ ମଦଖବିା ପାଇ ିଁ ମସମାମନ କଣ କରିମବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

46. To stop video time at 58 seconds in VLC Media Player. 

  

Stop video here and ask if they can tell how to type in blank slide? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ blank slide ମର 

କିପରି ଟାଇପ କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

47. To stop video time at 1 minute 13 seconds in VLC Media 

Player. 

 

Stop video here and ask which option will be used for sending a 

document to another user? 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ମଗାଟିଏ document କୁ ଆଉ ଜଣଙୁ୍କ ପଠାଇବା 

ପାଇ ିଁ ମକଉ ିଁ ଅପ୍ଶନ ର ବୟବହାର ମହାଇଥାଏ ।  

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

48. To stop video time at 1 minute 26 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell where is the slide pane located in 

the ‘Impress’ file. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ‘Impress’ ଫାଇ଱ 

ମର slide pane ମକଉ ିଁଠାମର ରହଥିାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

49. To stop video time at 1 minute 53 seconds in VLC Media 

Player. 

 

Stop video here and ask which option will be used to know all the 

information about ‘Impress’ file? 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ‘Impress’ ବିଷୟମର ସମସ୍ତ ସଚୂନା ଜାଣବିା 

ପାଇ ିଁ ମକଉ ିଁ ଅପ୍ଶନ ର ବୟବହାର ମହାଇଥାଏ । 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

50. To stop video time at 2 minute 05 seconds in VLC Media 

Player. 

Stop video here and ask students to open ‘Impress file’ and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Impress file’ କୁ ଓମପନ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

51. To stop video time at 2 minute 15 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert 3 slides and type the given 

paragraph on the first slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ 3 ଟି ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

ପ୍ରଥମ slide ମର ଦିଆଯାଇଥବିା ପାରାଗ୍ରାଫ କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

52. To stop video time at 2 minute 42 seconds in VLC Media 

Player. 
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Stop video here and ask students to do practice of ‘Send’ option and 

then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Send’ ଅପ୍ଶନ ର ଅଭୟାସ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

53. To stop video time at 3 minute 32 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘File’ menu and select 

‘Document as email’ option and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Document as email’ ଅପ୍ଶନ କୁ 

ସିମ଱କ୍ଟ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

54. To stop video time at 4 minute 51 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

55. To stop video time at 5 minute 10 seconds in VLC Media 

Player. 
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Stop video here and ask students to apply ‘Template’ option and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Template’ ଅପ୍ଶନ ର ବୟବହାର କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

56. To stop video time at 5 minute 02 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘File’ menu and then 

select ‘Template’ option and then select the save option as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Template’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର save ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

57. To stop video time at 7 minute 42 seconds in VLC Media 

Player. 

Stop video here and ask students to ‘Export’ the document as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

document  କୁ ‘Export’ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

58. To stop video time at 08 minute 23 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 
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Now just check whether they have made ‘Template’ or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Template’  ିଆରି କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

59. To stop video time at 08 minute 32 seconds in VLC Media 

Player. 

 

Stop video here and ask students to create the ‘Fax’ format and the play 

the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Fax format’  ିଆରି କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

60. To stop video time at 08 minute 59 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘File’ menu and then 

select ‘Fax’ option of ‘Wizard’ as shown in the video and then play the 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Wizard’ ର ‘Fax’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

61. To stop video time at 09 minute 20 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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62. To stop video time at 10 minute 54 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have Created ‘Fax format’ or not and play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Fax format’  ିଆରି କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

63. To stop video time at 10 minute 57 seconds in VLC Media 

Player. 

 

Stop video here and ask students to do practice of ‘Printer setting’ 

option and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Printer setting’ ଅପ୍ଶନ ର ଅଭୟାସ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

64. To stop video time at 11 minute 29 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘File’ menu and then 

select ‘Printer setting’ option as shown in the video and then play the 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘File 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Printer setting’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

65. To stop video time at 14 minute 26 seconds in VLC Media 

Player. 
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Stop video here and ask students to use the ‘Advance and Printing 

setting’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Advance 

and Printing setting’ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

 

66. To stop video time at 16 minute 06 seconds in VLC Media 

Player. 

Stop video here and ask students to use the ‘paper quality and Effect’ as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘paper 

quality and Effect’ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

67. To stop video time at 17 minute 30 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘Printer setting’ option or 

not and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Printer setting’ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

68. To stop video time at 17 minute 35 seconds in VLC Media 

Player. 
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Stop video here and ask students to do practice of ‘Preview in web 

browser’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Preview in web browser’ ର ଅଭୟାସ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

69. To stop video time at 19 minute 28 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘Preview in web browser’ or 

not and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Preview in web browser’ ର ଅଭୟାସ କରିଛନି୍ତ 

କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

70. To stop video time at 19 minute 40 seconds in VLC Media 

Player. 

 

Stop video here and ask students to hide some options such as ‘Save’ 

‘open’ and ‘Hyperlink’ from ‘Standard toolbar’ and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Standard toolbar’ ରୁ କିଛି ଅପ୍ଶନ ଗଡୁିକୁ 

଱ୁଚାଇବା ପାଇ ିଁ କୁହ ମଯମି ିକି ‘Save’ ‘open’ ଏବଂ ‘Hyperlink’ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

71. To stop video time at 21 minute 00 seconds in VLC Media 

Player. 
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Stop video here and ask students to unselect these options and click on 

‘OK’ button as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଏହ ିଅପ୍ଶନ 

ଗଡୁିକୁ unselect କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘OK’ button କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

72. To stop video time at 21 minute 31 seconds in VLC Media 

Player. 

 

Stop video here and ask students to draw their name on the slide with 

help of ‘Fontwork’ option and also do formatting on it and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Fontwork’ ଅପ୍ଶନ ସାହାଯୟ ମର ସ୍ାିଇଡ 

ମର ମସମାନଙ୍କର ନାମ  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ ମସଥମିର formatting କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

73. To stop video time at 22 minute 49 seconds in VLC Media 

Player. 

Stop video here and ask students to insert ‘Font work gallery’ as shown 

in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Font 

work gallery’ କୁ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

74. To stop video time at 23 minute 43 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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75. To stop video time at 26 minute 34 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘Fontwork’ option or not 

and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Fontwork’ ଅପ୍ଶନ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ ।  

 

 

 

 

 

76. To stop video time at 26 minute 49 seconds in VLC Media 

Player. 

 

Stop video here and ask students to bring back those options which they 

had hidden and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସହ ିଅପ୍ଶନ ଗଡୁିକୁ ପନୁବତାର ମଫରାଇ 

ଆଣବିା ପାଇ ିଁ କୁହ ମଯଉ ିଁ ଗଡୁିକୁ ମସମାମନ ଱ୁଚାଇଥମି଱ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

77. To stop video time at 28 minute 08 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have gotten back those options or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ମସହ ିଅପ୍ଶନ ଗଡୁିକୁ ମଫରାଇ ଆଣଛିନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

78. To stop video time at 28 minute 31 seconds in VLC Media 

Player. 

 

Stop video here and ask students to close their file and shout down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office impress 2 Class 5 

Class 5 Summaries 

 

 Why we use ‘Points’. 

ଆମମ ‘Points’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Glue points’ option? 

ଆମମ ‘Glue points’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Field option’? 

ଆମମ ‘Field’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to do any ‘Formatting’ on drawing? 

ଚିତ୍ର ମର ମକୌଣସି ‘Formatting’ କିପରି କରାଯାଏ ? 

 How to insert a new slide? 

ମଗାଟିଏ ନୂଆ slide କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 How to use ‘Slide master’?  

‘Slide master’ କୁ କିପରି ବୟବହାର କରାଯାଏ ? 

 How to hide and unhide ‘Comments’? 

‘Comments’ କୁ କିପରି hide ଏବଂ unhide କରାଯାଏ ? 

 How to insert comment? 

Comment  କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 What happens by ‘Navigator’ option? 

‘Navigator’ ଅପ୍ଶନ ଦ୍ଵାରା କଣ ମହାଇଥାଏ ? 

 Why we use ‘Zoom’ option? 

ଆମମ ‘Zoom’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to insert ‘Date’, ‘Time’ and ‘Page number’? 

‘Date’, ‘Time’ ଏବଂ ‘Page number’ କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 
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79. To stop video time at 58 seconds in VLC Media Player. 

80.  

 

Stop video here and ask if they can tell why we use ‘Line and filling’ 

toolbar? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Line and 

filling’ toolbar କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

81. To stop video time at 3 minute 33 seconds in VLC Media 

Player. 

Stop video here and ask students to hide and unhide the ‘Slide pane’ as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Slide 

pane’ କୁ hide ଏବଂ unhide କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

82. To stop video time at 3 minute 38 seconds in VLC Media 

Player. 
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Stop video here and ask if they know what is ‘Properties option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Properties’ ଅପ୍ଶନ 

କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

83. To stop video time at 4 minute 24 seconds in VLC Media 

Player. 

 

Stop video here and ask there are how many methods to print ‘Impress 

file’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ‘Impress file’ କୁ ପି୍ରଣ୍ଟ କରିବା ପାଇ ିଁ ମକମ ାଟି 

ମାଧ୍ୟମ ଅଛି ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

84. To stop video time at 5 minute 12 seconds in VLC Media 

Player. 

Stop video here and ask to if they know which shortcut command will be 

used to get a print out? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ମଗାଟିଏ print out 

ମନବା ପାଇ ିଁ ମକଉ ିଁ shortcut command ର ବୟବହାର କରାଯିବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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85. To stop video time at 5 minute 29 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Templates’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Templates’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

86. To stop video time at 6 minute 06 seconds in VLC Media 

Player. 

 

Stop video here and ask students to open ‘Impress file’ and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ Impress file କୁ ଓମପନ କରିବା  

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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87. To stop video time at 6 minute 04 seconds in VLC Media 

Player. 

 

Stop video here and ask students to type the given paragraph on the 

first slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପ୍ରଥମ slide ମର ଦିଆଯାଇଥବିା ପାରାଗ୍ରାଫ 

କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

88. To stop video time at 9 minute 24 seconds in VLC Media 

Player. 

Stop video here and ask students to insert 10 (ten) slides. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ 10 ଟି ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ 

Now just check and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

89. To stop video time at 10 minute 28 seconds in VLC Media 

Player. 

Stop video here and ask students to draw shape as shown in the video 

and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି shape 

 ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

90. To stop video time at 11 minute 49 seconds in VLC Media 

Player. 
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Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

91. To stop video time at 18 minute 01 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have drawn some shapes in slides numbers 

2 to 8 or not and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ଦି୍ଵ ୀୟ ଏବଂ ଅଷ୍ଟମ ସ୍ାିଇଡ ମର କିଛି shape  ିଆରି 

କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

92. To stop video time at 18 minute 26 seconds in VLC Media 

Player. 

 

Stop video here and ask why we use ‘Points’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଆମମ ‘Points’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

93. To stop video time at 19 minute 17 seconds in VLC Media 

Player. 
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Stop video here and ask students to draw a line as shown in the video 

and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

଱ାଇନ  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

 

94. To stop video time at 20 minute 00 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Edit menu’ and then 

click ‘Points’ opiton as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Edit 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Points’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

95. To stop video time at 20 minute 45 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

96. To stop video time at 21 minute 38 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

97. To stop video time at 22 minute 33 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

98. To stop video time at 25 minute 15 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Points option’ or not and play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Points option’ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

99. To stop video time at 25 minute 26 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Glue Points’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Glue Points’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

100. To stop video time at 26 minute 38 seconds in VLC Media 

Player. 

Stop video here and ask students to draw two shapes as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଦୁଇଟି 

shape  ିଆରି  କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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101. To stop video time at 28 minute 09 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Edit menu’ and then 

click ‘Points’ opiton as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Edit 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Points’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

102. To stop video time at 30 minutes 50 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Just check and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

103. To stop video time at 30 minutes 58 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Fields’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Fields’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

104. To stop video time at 33 minutes 14 seconds in VLC Media 

Player. 
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Stop video here and ask students to insert ‘Date’, ‘Time’ and ‘Page 

number’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Date’, 

‘Time’ ଏବଂ ‘Page number’ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର  

ଚ଱ାଅ । 

 

 

 

 

105. To stop video time at 35 minutes 11 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have changed formatting of ‘Fields’ or not 

and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Fields’ ର  formatting ମଚଞ୍ଜ କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

106. To stop video time at 35 minutes 30 seconds in VLC Media 

Player. 

 

Stop video here and ask students if they remember what options they 

learnt in ‘View menu’? 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପଚାର ଯଦି ମସମାମନ ମମନରଖଛିନି୍ତ ‘View 

menu’ ର ମକଉ ିଁ ଅପ୍ଶନ ଗଡୁିକ ମସମାମନ ଶଖିଥିମି଱ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

107. To stop video time at 36 minutes 05 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Slide master’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Slide 

master’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

108. To stop video time at 37 minutes 53 seconds in VLC Media 

Player. 

Stop video here and ask students to insert a slide and type some lines in 

slide with some title as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ ସ୍ାିଇଡ ମର title ସହ କିଛି line ଟାଇପ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

109. To stop video time at 39 minutes 59 seconds in VLC Media 

Player. 
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Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

। 

110. To stop video time at 44 minutes 43 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Master slide’ or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Master slide’ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

111. To stop video time at 44 minutes 54 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use the ‘Color and 

grayscale’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Color and 

grayscale’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

112. To stop video time at 46 minutes 11 seconds in VLC Media 

Player. 
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Stop video here and ask students to do formatting as shown in the video 

and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

formatting କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

113. To stop video time at 47 minutes 01 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘color and grayscale’ or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘color and grayscale’ କୁ ବୟବହାର କରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

114. To stop video time at 47 minutes 21 seconds in VLC Media 

Player. 

 

Stop video here and ask students to hide and unhide the comment box 

as and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ comment box କୁ hide ଏବଂ unhide 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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115. To stop video time at 48 minutes 01 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then 

select ‘Comment’ option as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Insert 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Comment’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

116. To stop video time at 49 minutes 01 seconds in VLC Media 

Player. 

Stop video here and ask students to type some lines in the ‘Comment 

box’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

‘Comment box’ ମର କିଛି ଱ାଇନ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

117. To stop video time at 50 minutes 00 seconds in VLC Media 

Player. 

Stop video here and ask students to hide and unhide the ‘Comment’ as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

‘Comment’ କୁ hide ଏବଂ unhide କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

 

118. To stop video time at 50 minutes 13 seconds in VLC Media 

Player. 
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Stop video here and ask if they know what happens with ‘Navigator’ and 

why we use it? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Navigator’ 

ଡ଼ିଡ଼ବ଱ଇଉର କଣ ମହାଇଥାଏ ଏବଂ ଆମମ ଏହାକୁ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

119. To stop video time at 51 minutes 23 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘View’ menu’ and then 

select ‘Navigator’ option as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘View 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Navigator’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

120. To stop video time at 53 minutes 32 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Navigator’ or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Navigator’ ଅପ୍ଶନ କୁ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

121. To stop video time at 54 minutes 26 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘View’ menu’ and then 

select ‘Zoom’ option as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘View 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Zoom’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 



79 
 

122. To stop video time at 55 minutes 07 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

123. To stop video time at 58 minutes 07 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Zoom’ or not and play the video 

again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Zoom’ ଅପ୍ଶନ କୁ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

124. To stop video time at 58 minutes 19 seconds in VLC Media 

Player. 

 

Stop video here and ask students to close their file and shut down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office impress 2 Class 6 

Summaries 

 

 Why we use ‘Points’. 

ଆମମ ‘Points’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to make a slide in normal view? 

ମଗାଟିଏ ସ୍ାିଇଡ କୁ normal view କୁ ମକମି ି କରିବ ? 

 Why we use ‘Glue points’ option? 

ଆମମ ‘Glue points’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Field option’? 

ଆମମ ‘Field’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to do any ‘Formatting’ on drawing? 

ଚିତ୍ର ମର ମକୌଣସି ‘Formatting’ କିପରି କରାଯାଏ ? 

 How to insert a new slide? 

ମଗାଟିଏ ନୂଆ slide କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 How to use ‘Slide master’?  

‘Slide master’ କୁ କିପରି ବୟବହାର କରାଯାଏ ? 

 How to hide and unhide ‘Comments’? 

‘Comments’ କୁ କିପରି hide ଏବଂ unhide କରାଯାଏ ? 

 How to insert comment? 

Comment  କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 What happens by ‘Navigator’ option? 

‘Navigator’ ଅପ୍ଶନ ଦ୍ଵାରା କଣ ମହାଇଥାଏ ? 

 Why we use ‘Zoom’ option? 

ଆମମ ‘Zoom’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to insert ‘Date’, ‘Time’ and ‘Page number’? 

‘Date’, ‘Time’ ଏବଂ ‘Page number’ କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 
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125. To stop video time at 1 minute 21 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know which shortcut command will be 

used for ‘Slide show’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ‘Slide show’ ପାଇ ିଁ 

ମକଉ ିଁ shortcut command ବୟବହାର ମହବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

126. To stop video time at 1 minute 41 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell what happens with ‘side bar’ and 

how to hide this? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ‘side bar’ ଦ୍ଵାରା 

କଣ ମହାଇଥାଏ ଏବଂ ଏହାକୁ କିପରି ଱ୁଚାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 



82 
 

 

 

127. To stop video time at 2 minute 14 seconds in VLC Media 

Player. 

 

Stop video here and ask if slide view has been changed, how to bring 

back in normal view? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି slide view ମଚଞ୍ଜ ମହାଇଯାଏ , ମ ମବ 

 ାହାକୁ କିପରି normal view ଅଣାଯିବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

128. To stop video time at 2 minute 43 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Fields’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Fields’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 
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ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

129. To stop video time at 2 minute 59 seconds in VLC Media 

Player. 

 

Stop video here and ask students to open ‘Impress file’ and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ Impress file କୁ ଓମପନ କରିବା  

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

130. To stop video time at 3 minute 19 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell what they learnt in previous 

class? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ମସମାମନ ପବୂତ କ୍ିାସ 

ମର କଣ ଶଖିଥିମି଱ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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131. To stop video time at 3 minute 40 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert 4 slides and type the given 

paragraph on the first slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ 4 ଟି slide  ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

ପ୍ରଥମ slide ମର ଦିଆଯାଇଥବିା ପାରାଗ୍ରାଫ କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

132. To stop video time at 3 minute 39 seconds in VLC Media 

Player. 

 

Stop video here and ask students to change their name style with help of 

‘Font work’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Font work’ ସାହାଯୟ ମର ମସମାନଙ୍କର 

ନାମ ର style କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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133. To stop video time at 4 minute 28 seconds in VLC Media 

Player. 

Stop video here and ask students to insert three slides as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 3 ଟି slide  

ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

134. To stop video time at 8 minute 11 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Font work’ or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Font work’ କୁ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

135. To stop video time at 8 minute 22 seconds in VLC Media 

Player. 

 

Stop video here and ask them if they know how many ways one can view 

a slide? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଜମଣ ମଗାଟିଏ ସ୍ାିଇଡ କୁ 

ମକମ ାଟି ମାଧ୍ୟମମର ମଦଖପିାରିବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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136. To stop video time at 8 minute 51 seconds in VLC Media 

Player. 

 

Stop video here and ask the students to change the view of the slide and 

bring back into normal view and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ସ୍ାିଇଡ ର view କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାହାକୁ ପନୁବତାର normal view କୁ ଆଣବିା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

137. To stop video time at 9 minute 40 seconds in VLC Media 

Player. 

Stop video here and ask students to change the view of the slide as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ସ୍ାିଇଡ ର 

view କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

138. To stop video time at 11 minute 46 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have changed the view of the slides or not 

and play the video again. 
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ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ସ୍ାିଇଡ ର view କୁ ମଚଞ୍ଜ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

139. To stop video time at 11 minute 58 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert some pictures and write some 

comments on the slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ କିଛି ଚିତ୍ର ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

ସ୍ାିଇଡ ମର କିଛି comments ମ଱ଖବିା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର  

ଚ଱ାଅ । 

140. To stop video time at 13 minute 35 seconds in VLC Media 

Player. 

Stop video here and ask students to insert the comment box and type 

some text in it as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି comment 

box ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ ମସଥମିର କିଛି ମଟକ୍ସଟ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

141. To stop video time at 14 minute 35 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 
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Now just check whether they have hidden the comments or not and play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ comments କୁ ଱ୁଚାଇଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

142. To stop video time at 15 minute10 seconds in VLC Media 

Player. 

 

Stop video here and ask, how to see the picture in the slide and how to 

move from one picture to another? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର slide ମର ଚିତ୍ର କୁ କିପରି ମଦଖପିାରିବ ଏବଂ 

ମଗାଟିଏ ଚିତ୍ର ରୁ ଆଉ ମଗାଟିଏ ଚିତ୍ର କୁ କିପରି ଯାଇପାରିବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

143. To stop video time at 15 minute 48 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘View menu’ and then 

select the ‘Navigator’ option as shown in the video and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘View 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Navigator’ ଅପ୍ଶନ କୁ ସିମ଱କ୍ଟ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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144. To stop video time at 17 minute 10 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘Navigator’ option or not 

and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Navigator’ ଅପ୍ଶନ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

145. To stop video time at 17 minute 25 seconds in VLC Media 

Player. 

 

Stop video here and ask students to show ‘Comment’ which they had 

hidden and type ‘Computer Shiksha’ in the comment box and then play 

the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପଚାର ମସମାମନ ଱ୁଚାଇଥବିା ‘Comment’ 

କୁ କିପରି ମଦଖମିବ ଏବଂ comment box ମର ‘Computer Shiksha’ ଟାଇପ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

146. To stop video time at 18 minute 14 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have shown the ‘Comment’ or not and then 

play the video again. 
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ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Comment’ କୁ ମଦଖାଇଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

 

 

 

147. To stop video time at 18 minute 34 seconds in VLC Media 

Player. 

 

Stop video here and ask students, how will they show and use the master 

slide option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପଚାର ମସମାମନ କିପରି master slide 

ଅପ୍ଶନ କୁ ମଦଖାଇ ପାରିମବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

148. To stop video time at 19 minute 16 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘View menu’ and then 

click on the ‘Master slide’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘View 

menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Master slide’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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149. To stop video time at 23 minute 24 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘Master slide’ or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Master slide’ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

150. To stop video time at 23 minute 34 seconds in VLC Media 

Player. 

 

Stop video here and ask how will they hide ‘Side bar’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ମସମାମନ ‘Side bar’ କୁ କିପରି ଱ୁଚାଇମବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

151. To stop video time at 24 minute 58 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced the ‘Sidebar’option or not 

and play the video again. 
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ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Sidebar’ ଅପ୍ଶନ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

 

 

 

152. To stop video time at 25 minute 06 seconds in VLC Media 

Player. 

 

Stop video here and ask students to hide ‘Line and filling, ‘Drawing bar’ 

and ‘Standard toolbar’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Line and filling, ‘Drawing bar’ ଏବଂ 

‘Standard toolbar’ କୁ ଱ୁଚାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

153. To stop video time at 25 minute 56 seconds in VLC Media 

Player. 

Stop video here and ask students to hide ‘Drawing toolbar’ as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Drawing 

toolbar’ କୁ ଱ୁଚାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

154. To stop video time at 26 minute 54 seconds in VLC Media 

Player. 

Stop video here and ask students to hide ‘Line and filling toolbar’ and 

‘Standard toolbar’ as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Line and 

filling toolbar’ ଏବଂ ‘Standard toolbar’ କୁ ଱ୁଚାଇବା ପାଇ ିଁ କୁହ । 

Now just check whether they have used the ‘Toolbar’ option or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Toolbar’ ଅପ୍ଶନ କୁ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

155. To stop video time at 27 minute 07 seconds in VLC Media 

Player. 

 

Stop video here and ask students to show ‘Standard toolbar’, ‘Line and 

filling’ and ‘Drawing toolbar’ then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Standard toolbar’ ‘Line and filling, 

ଏବଂ ‘Drawing bar’ କୁ ମଦଖାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

156. To stop video time at 28 minute 14 seconds in VLC Media 

Player. 

Stop video here and ask students to show ‘Drawing toolbar’ as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Drawing bar’ କୁ ମଦଖାଇବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

157. To stop video time at 28 minute 49 seconds in VLC Media 

Player. 

Stop video here and ask students to do show ‘Line and filling’ toolbar’ 

and ‘Standard toolbar’ as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Line and filling ଏବଂ ‘Standard 

toolbar’ କୁ ମଦଖାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

Now just check and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

 

 

158. To stop video time at 29 minute 06 seconds in VLC Media 

Player. 

 

Stop video here and ask students to draw two objects and join them with 

help of ‘Glue points’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଦୁଇଟି object  ିଆରି କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ ‘Glue points’ ସାହାଯୟ ମର ମସହଗିଡୁିକୁ  join କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

159. To stop video time at 29 minute 59 seconds in VLC Media 

Player. 

Stop video here and ask students to draw two objects as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଦୁଇଟି 

object  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

160. To stop video time at 31 minute 01 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘Glue points’ or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Glue points’ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

161. To stop video time at 31 minute 14 seconds in VLC Media 

Player. 

 

Stop video here and ask students to draw a line and use ‘Points’ in this 

line and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଗାଟିଏ ଱ାଇନ  ିଆରି କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ ମସହ ି଱ାଇନ ମର  ‘Points’  ର ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

162. To stop video time at 31 minute 53 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

163. To stop video time at 33 minute 16 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they practiced ‘Points’ or not and play the video 

again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Points’ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

164. To stop video time at 33 minute 28 seconds in VLC Media 

Player. 

 

Stop video here and ask students to close their file and shut down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office Impress 2 Class 7 

Class 7 Summaries 

 

 Why we use ‘Expand and summary slide’? 

ଆମମ ‘Expand and summary slide’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘animated image’ option? 

ଆମମ ‘animated image’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Movie and sound’? 

ଆମମ ‘Movie and sound’କାହି ିଁକି ବୟବହାର କରୁ ? 

 What is ‘object’ and ‘chart’ option? 

‘object’ ଏବଂ ‘chart’ ଅପ୍ଶନ କଣ ? 

 Why we use ‘position and size’? 

ଆମମ ‘position and size’କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘line’ option? 

ଆମମ ‘line’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 What is area option? 

Area ଅପ୍ଶନ କଣ ? 

 How to crop a picture? 

ମଗାଟିଏ ଚିତ୍ର କୁ କିପରି crop କରାଯାଏ ? 

 How to use style and formatting? 

style ଏବଂ formatting କୁ କିପରି ବୟବହାର କରାଯାଏ ? 

 How to correct spelling? 

Spelling କୁ କିପରି ଠିକ୍ କରାଯାଏ ? 

 How to change language? 

Language କୁ କିପରି ମଚଞ୍ଜ କରାଯାଏ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 
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165. To stop video time at 35 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell what they learnt in previous 

class? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ମସମାମନ ପବୂତ କ୍ିାସ 

ମର କଣ ଶଖିଥିମି଱ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

166. To stop video time at 57 seconds in VLC Media Player. 

 

Stop video here and ask what they had learnt in ‘Standard toolbar’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ମସମାମନ ‘Standard toolbar’ ଅପ୍ଶନ ମର କଣ 

ଶଖିଥିମି଱ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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167. To stop video time at 1 minute 33 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell how to hide ‘Grid’ from ‘Impress 

file’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ‘Impress file’ ରୁ 

‘Grid’ ଅପ୍ଶନ କୁ କିପରି ଱ୁଚାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

168. To stop video time at 2 minute 01 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Points’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Points’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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169. To stop video time at 2 minute 32 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Fields’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Fields’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

170. To stop video time at 2 minute 55 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Hyperlink’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Hyperlink’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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171. To stop video time at 3 minute 22 seconds in VLC Media 

Player. 

 

Stop video here and ask students to open ‘Impress file’ and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ Impress file କୁ ଓମପନ କରିବା  

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

172. To stop video time at 4 minute 52 seconds in VLC Media 

Player. 

Stop video here and ask students to type the given paragraph on the 

slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ slide ମର ଦିଆଯାଇଥବିା ପାରାଗ୍ରାଫ କୁ 

ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

173. To stop video time at 5 minute 12 seconds in VLC Media 

Player. 
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Stop video here and ask if they know why we use ‘Summary slide’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Summary 

slide’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

174. To stop video time at 6 minute 06 seconds in VLC Media 

Player. 

Stop video here and ask students to insert a slide and then give the title 

and also draw an object as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଗାଟିଏ ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର title ମଦବା ପାଇ ିଁ କୁହ ଏବଂ ମଗାଟିଏ object ମଧ୍ୟ  ିଆରି କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

175. To stop video time at 7 minute 39 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

176. To stop video time at 7 minute 48 seconds in VLC Media 

Player. 
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Stop video here and ask if they can tell why we use ‘Expand slide’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Expand 

slide’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

177. To stop video time at 9 minute 17 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have applied Expand slide or not and play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Expand slide’ ର ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

178. To stop video time at 9 minute 26 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Animated image’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ  ଆମମ ‘Animated 

image’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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179. To stop video time at 10 minute 56 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Insert menu’ and then 

select ‘Animated image’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Insert menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Animated image’ କୁ ସିମ଱କ୍ଟ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

180. To stop video time at 12 minute 33 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

181. To stop video time at 14 minute 39 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

182. To stop video time at 15 minute 37 seconds in VLC Media 

Player. 

Stop video here and ask students to click on ‘Insert menu’ and then click 

on the ‘Movie and Sound’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  
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‘Insert menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Movie and Sound’ ଉପମର 

କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

183. To stop video time at 17 minute 34 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have inserted a video or not and then play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ଭିଡିଓ କୁ ଇନସଟତ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

184. To stop video time at 17 minute 41 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Object’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Object’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହା ର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

185. To stop video time at 19 minute 03 seconds in VLC Media 

Player. 
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Stop video here and ask students to click on the ‘Insert menu’ and then 

click on ‘Object’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Insert menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Object’ ଉପମର କିି୍କ୍ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

186. To stop video time at 22 minute 16 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

187. To stop video time at 23 minute 45 seconds in VLC Media 

Player. 

Stop video here and ask students to draw an object and also ask to copy 

and paste as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

object  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାହାକୁ copy ଏବଂ paste କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

188. To stop video time at 24 minute 28 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

189. To stop video time at 28 minute 06 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Position and Size’ option or not 

and then play the video again. 



107 
 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Position and size’ ଅପ୍ଶନ ର ବୟବହାର କରିଛନି୍ତ 

କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

190. To stop video time at 29 minute 08 seconds in VLC Media 

Player. 

Stop video here and ask students to draw a ‘Line’ as shown in the video 

and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

‘Line’  ିଆରି formatting କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

191. To stop video time at 33 minute 05 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

192. To stop video time at 33 minute 28 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used the ‘Line’ option or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Line’ ଅପ୍ଶନ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

193. To stop video time at 33 minute 38 seconds in VLC Media 

Player. 
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Stop video here and ask if they know why we use ‘Area’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Area’ ଅପ୍ଶନ 

କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

194. To stop video time at 34 minute 38 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Format menu’ and then 

click on ‘Area’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Format menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Area’ ଅପ୍ଶନ ଉପମର କିି୍କ୍ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

195. To stop video time at 35 minute 19 seconds in VLC Media 

Player. 

Stop video here and ask students to use the ‘Shadow’ option as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Shadow’ 

ଅପ୍ଶନ ର ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

196. To stop video time at 41 minute 39 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Area’ option and then play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Area’ ଅପ୍ଶନ ର ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

 

197. To stop video time at 41 minute 44 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know what happens with ‘Text’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Text’ ଅପ୍ଶନ ଦ୍ଵାରା କଣ 

ମହାଇଥାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

198. To stop video time at 42 minute 44 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Format menu’ and then 

click on ‘Text’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Format menu’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Text’ ଅପ୍ଶନ ଉପମର କିି୍କ୍ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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199. To stop video time at 44 minute 24 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

200. To stop video time at 45 minute 55 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have applied ‘text animation’ or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘text animation’ ର ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

201. To stop video time at 46 minute 00 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we ‘Crop picture’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Crop picture’ 

କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

202. To stop video time at 47 minute 42 seconds in VLC Media 

Player. 
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Stop video here and ask students to click on the ‘Format menu’ and then 

click on ‘Crop picture’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Format menu’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Crop picture’ ଅପ୍ଶନ ଉପମର 

କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

203. To stop video time at 48 minute 25 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

204. To stop video time at 49 minute 17 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Crop picture’ or not and play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Crop picture’ ର ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

205. To stop video time at 50 minute 10 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Format menu’ and then 

click on ‘Style and formatting’ as shown in the video and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Format menu’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Style and formatting’ କୁ 

କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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। 

206. To stop video time at 51 minute 50 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

207. To stop video time at 52 minute 55 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Formatting and style’ or not and 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Formatting and style’ ର ବୟବହାର କରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

208. To stop video time at 53 minute 31 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell what is ‘Color replacer’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ  ‘Color replacer’ 

ଅପ୍ଶନ କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 
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ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

209. To stop video time at 54 minute 30 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then 

click on ‘Color replacer’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Tools menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Color replacer’ କୁ କିି୍କ୍ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

210. To stop video time at 56 minute 09 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have replaced the picture’s color or not 

and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ଚିତ୍ର ର color କୁ replace କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

211. To stop video time at 57 minute 05 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then 

click on ‘Media player’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Tools menu’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Media player’ କୁ କିି୍କ୍ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

212. To stop video time at 57 minute 52 seconds in VLC Media 

Player. 

Stop video here and ask students to insert any video as shown in the 

video and then play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଯମକୌଣସି 

ଭିଡିଓ କୁ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

213. To stop video time at 59 minute 30 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have inserted any video or not and play the 

video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ମକୌଣସି ଭିଡିଓ କୁ ଇନସଟତ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

214. To stop video time at 59 minute 39 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Minimize presentation’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ  ଆମମ ‘Minimize 

presentation’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

215. To stop video time at 1 Hour 00 minute 39 seconds in VLC 

Media Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then 

click on ‘Minimize presentation’ as shown in the video and then play the 

video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Tools menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Minimize presentation’ କୁ 

କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

216. To stop video time at 1 Hour 01 minute 26 seconds in VLC 

Media Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

217. To stop video time at 1 Hour 02 minute 21 seconds in VLC 

Media Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Minimize presentation’ or not 

and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Minimize presentation’ ର ବୟବହାର କରିଛନି୍ତ 

କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

218. To stop video time at 1 Hour 02 minute 35 seconds in VLC 

Media Player. 

 

Stop video here and ask students to close their file and shut down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office Impress 2 Class 8 

Summaries 

 

 Why we use ‘Expand and summary slide’? 

ଆମମ ‘Expand and summary slide’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘animated image’ option? 

ଆମମ ‘animated image’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Movie and sound’? 

ଆମମ ‘Movie and sound’କାହି ିଁକି ବୟବହାର କରୁ ? 

 What is ‘object’ and ‘chart’ option? 

‘object’ ଏବଂ ‘chart’ ଅପ୍ଶନ କଣ ? 

 Why we use ‘position and size’? 

ଆମମ ‘position and size’କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘line’ option? 

ଆମମ ‘line’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 What is area option? 

Area ଅପ୍ଶନ କଣ ? 

 How to crop a picture? 

ମଗାଟିଏ ଚିତ୍ର କୁ କିପରି crop କରାଯାଏ ? 

 How to use style and formatting? 

style ଏବଂ formatting କୁ କିପରି ବୟବହାର କରାଯାଏ ? 

 How to correct spelling? 

Spelling କୁ କିପରି ଠିକ୍ କରାଯାଏ ? 

 How to change language? 

Language କୁ କିପରି ମଚଞ୍ଜ କରାଯାଏ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 
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219. To stop video time at 41 seconds in VLC Media Player. 

 

Stop video here and ask if they remember what they learnt in previous 

class? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ମମନରଖଛିନି୍ତ ମସମାମନ ପବୂତ 

କ୍ିାସ ମର କଣ ଶଖିଥିମି଱ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

220. To stop video time at 01minute 05 seconds in VLC Media 

Player. 

 

 

 

Stop video here and ask if they know what is ‘Animated image’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Animated image’ 

କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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221. To stop video time at 1 minute 36 seconds in VLC Media 

Player. 

 

Stop video here and ask which option is used to play ‘MP3 or video’ file 

in impress slide? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର impress slide ସ୍ାିଇଡ ମର ‘MP3 or video’ 

ଫାଇ଱ କୁ ଚଲାଇବା ପାଇ ିଁ ମକଉ ିଁ ଅପ୍ଶନ ର ବୟବହାର ମହାଇଥାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

222. To stop video time at 2 minute 05 seconds in VLC Media 

Player. 

 

Stop video here and ask if we can cut picture using ‘crop picture’ option 

or not? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଆମମ ‘crop picture’ ଅପ୍ଶନ ର ବୟବହାର କରି 

ଚିତ୍ର କୁ cut କରିପାରିବା ନା ନାହି ିଁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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223. To stop video time at 2 minute 27 seconds in VLC Media 

Player. 

 

Stop video here and ask what is shortcut command for ‘spelling’?  

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ‘spelling’ ପାଇ ିଁ shortcut command କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

224. To stop video time at 2 minute 48 seconds in VLC Media 

Player. 

 

Stop video here and ask where are ‘text, area, line and styles and 

formatting’ options ?  

 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ‘text, area, line and styles ଏବଂ 

formatting’ ଅପ୍ଶନ ଗଡୁିକ ମକଉ ିଁଠାମର ଅଛି ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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225. To stop video time at 2 minute 58 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell what is ’color replacer’?  

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ’color replacer’ 

କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

226. To stop video time at 3 minute 20 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘minimize 

presentation’?  

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ  ଆମମ ‘minimize 

presentation’ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 
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ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

227. To stop video time at 4 minute 06 seconds in VLC Media 

Player. 

 

Stop video here and ask students to first select title slide and then play 

the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପ୍ରଥମମ title slide କୁ ସିମ଱କ୍ଟ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

228. To stop video time at 4 minute 16 seconds in VLC Media 

Player. 

 

Stop video here and ask students to type the given line and then play 

the video  

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଦିଆଯାଇଥବିା ଱ାଇନ କୁ ଟାଇପ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

229. To stop video time at 5 minute 08 seconds in VLC Media 

Player. 
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Stop video here and ask students to copy paste the line as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଱ାଇନ କ ୁ

copy paste କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

230. To stop video time at 5 minute 22 seconds in VLC Media 

Player. 

 

Stop video here and ask students to bring up the new slide and then ask 

to use movie and sound. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଗାଟିଏ ନୂଆ ସ୍ାିଇଡ ମନବା ପାଇ ିଁ କୁହ ଏବଂ 

 ାପମର movie and sound କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ।  

231. To stop video time at 5 minute 57 seconds in VLC Media 

Player. 

Stop video here and ask students insert a new slide as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

ନୂଆ ସ୍ାିଇଡ କୁ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

232. To stop video time at 7 minute 23 seconds in VLC Media 

Player. 

Stop video here and ask students to insert the video and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଗାଟିଏ video ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

233. To stop video time at 8 minute 14 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have inserted the video or not and then 

play the video again. 

 ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ video ଇନସଟତ କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

234. To stop video time at 8 minute 26 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert the new slide and ask to make 

it as a summary slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଗାଟିଏ ନୂଆ ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାହାକୁ ମଗାଟିଏ summary slide କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

235. To stop video time at 8 minute 33 seconds in VLC Media 

Player. 

 

Stop video here and ask students to make the ‘Expand slide’ as shown in 

the video and then play again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Expand 

slide’ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

236. To stop video time at 10 minute 58 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Summary slide’ or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Summary slide’ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

237. To stop video time at 11 minute 15 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know how to use Animated image? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ   Animated image 

କୁ କିପରି ବୟବହାର କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

238. To stop video time at 12 minute 08 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Insert’ menu and then 

click ‘Animated image’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  
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‘Insert menu’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Animated image’ କୁ କିି୍କ୍ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

239. To stop video time at 15 minute 51 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check just whether they have made animated image or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ Animate ମହାଇଥବିା ଚିତ୍ର  ିଆରି କରିସାରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

240. To stop video time at 16 minute 10 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know how to use ‘Size and Position’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ  ‘Size and Position’ 

କୁ କିପରି ବୟବହାର କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

241. To stop video time at 16 minute 30 seconds in VLC Media 

Player. 

Stop video here and ask students to insert a new slide as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

ନୂଆ ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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242. To stop video time at 16 minute 49 seconds in VLC Media 

Player. 

Stop video here and ask students to draw an object as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

object  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ ।  

243. To stop video time at 18 minute 19 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Position and size’ option or not 

and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Position and size’ ଅପ୍ଶନ ର ବୟବହାର କରିଛନି୍ତ 

କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

244. To stop video time at 18 minute 21 seconds in VLC Media 

Player. 

 

Stop video here and ask students to draw a picture using ‘line Tool’ and 

also change the format of the line and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ  ‘line Tool’ କୁ ବୟବହାର କରି ମଗାଟିଏ 

ଚିତ୍ର  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ ଱ାଇନ ର format କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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245. To stop video time at 19 minute 12 seconds in VLC Media 

Player. 

Stop video here and ask students to draw as shown in the video and 

then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  ିଆରି 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

246. To stop video time at 20 minute 14 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

247. To stop video time at 21 minute 27 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have formatted the line or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ଱ାଇନ କୁ format କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

248. To stop video time at 21 minute 38 seconds in VLC Media 

Player. 
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Stop video here and ask if they know how to use ‘Area’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ  ‘Area’ ଅପ୍ଶନ କୁ କିପରି 

ବୟବହାର କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

249. To stop video time at 22 minute 18 seconds in VLC Media 

Player. 

Stop video here and ask students to insert a new slide and then draw an 

object and then play the video again.  

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଗାଟିଏ ନୂଆ ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ମଗାଟିଏ object  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

250. To stop video time at 22 minute 36 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Format menu’ and then 

click on the ‘Area’ option as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Format menu’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Area’ ଅପ୍ଶନ କୁ କ୍ିିକ୍ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

251. To stop video time at 25 minute 07 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘Area’ option or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Area’ ଅପ୍ଶନ କୁ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

252. To stop video time at 25 minute 18 seconds in VLC Media 

Player. 

 

Stop video here and ask students to type the given spelling as shown in 

the video and also tell how to check the spelling then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

ଦିଆଯାଇଥବିା spelling କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ spelling କୁ କିପରି check 

କରାଯିବ କୁହ  ାପମର  ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

253. To stop video time at 27 minute 09 seconds in VLC Media 

Player. 

Stop video here and ask students to type the given words as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

ଦିଆଯାଇଥବିା ଶବ୍ଦ କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

254. To stop video time at 28 minute 22 seconds in VLC Media 

Player. 
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Stop video here and ask students to correct the wrong spelling as shown 

in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଭୁ଱ 

spelling କୁ ସଠିକ୍ କରିବା ପାଇ ିଁ କୁହ ।  

Now just check whether they have corrected the spelling or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ spelling କୁ ସଠିକ୍ କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

255. To stop video time at 28 minute 40 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert any picture and then use the 

color replacer option to replace the color of the picture and then play 

the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଯମକୌଣସି ଚିତ୍ର କୁ ଇନସଟତ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଚିତ୍ର ମର color କୁ replace କରିବା ପାଇ ିଁ color replacer କୁ ବୟବହାର 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

256. To stop video time at 29 minute 32 seconds in VLC Media 

Player. 

Stop video here and ask students to insert a new slide and then insert a 

picture as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

ନୂଆ ସ୍ାିଇଡ କୁ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ମଗାଟିଏ ଚିତ୍ର କୁ ଇନସଟତ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

257. To stop video time at 30 minute 05 seconds in VLC Media 

Player. 
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Stop video here and ask students to do as shown in the video and then 

play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

258. To stop video time at 32 minute 05 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have replaced the color or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ color କୁ replace କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

259. To stop video time at 32 minute 16 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert any file/object on the sheet 

and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମଯମକୌଣସି ଫାଇ଱/object କୁ ଇନସଟତ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

260. To stop video time at 33 minute 15 seconds in VLC Media 

Player. 
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Stop video here and ask students to click on the video and then click on 

the ‘Object’ option as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

video କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Object’ ଅପ୍ଶନ କୁ କ୍ିିକ୍ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

261. To stop video time at 35 minute 21 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have inserted the file or not and then play 

the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ଫାଇ଱ କୁ ଇନସଟତ କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

262. To stop video time at 35 minute 30 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know what happens with ‘Minimize 

presentation’ and why we use it? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ   ‘Minimize 

presentation’ ଦ୍ଵାରା କଣ ମହାଇଥାଏ ଏବଂ ଆମମ ଏହାକୁ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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263. To stop video time at 36 minute 02 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then 

click on the ‘Minimize presentation’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Tools menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Minimize presentation’ 

ଉପମର କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

264. To stop video time at 38 minute 44 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have done the use of ‘Minimize 

presentation’ or not and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Minimize presentation’ କୁ ବୟବହାର କରିଛନି୍ତ 

କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

265. To stop video time at 38 minute 57 seconds in VLC Media 

Player. 

 

Stop video here and ask students to close their file and shut down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office Impress 2 Class 9 

Summaries 

 

 Why we use ‘Extension manager’? 

ଆମମ ‘Extension manager’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Auto correct’ option? 

ଆମମ ‘Auto correct’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Customize’ option’? 

ଆମମ ‘Customize’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to select any ‘Menu’? 

ମକୌଣସି ‘Menu’ କୁ କିପରି ସିମ଱କ୍ଟ କରାଯାଏ ? 

 How to design the slide? 

Slide କୁ କିପରି design କରାଯାଏ ? 

 Why we use ‘Option’?  

ଆମମ ‘Option’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Interaction’? 

ଆମମ ‘Interaction’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to apply effects on slide? 

Slide ମର effects କିପରି ଱ଗାଯାଏ ? 

 Why we use ‘Custom animation’? 

ଆମମ ‘Custom animation’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘slide transition’? 

ଆମମ ‘slide transition’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Custom slide show’? 

ଆମମ ‘Custom slide show’ କାହି ିଁକି ବୟବହାର କରୁ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 
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266. To stop video time at 30 seconds in VLC Media Player. 

 

Stop video here and ask if they know what they learnt in the previous 

class? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ମସମାମନ ପବୂତ କ୍ିାସ ମର 

କଣ ଶଖିଥିମି଱ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

267. To stop video time at 35 seconds in VLC Media Player. 

 

Stop video here and ask, if they know what can we change using ‘Area’ 

option’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ  ‘Area’ ଅପ୍ଶନ 

ବୟବହାର କରି କଣ ମଚଞ୍ଜ କରି ପାରିବା ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

268. To stop video time at 56 seconds in VLC Media Player. 
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Stop video here and ask what can we change using ‘Line option’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଆମମ  ‘Line’ ଅପ୍ଶନ ବୟବହାର କରି କଣ ମଚଞ୍ଜ 

କରି ପାରିବା ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

269. To stop video time at 1 minute 16 seconds in VLC Media 

Player. 

 

Stop video here and ask, in which Menu ‘Animated image’ can be found 

and why we use it? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ‘Animated image’ ମକଉ ିଁ ମମନୁ ମର 

ମିଲିପାରିବ ଏବଂ ଆମମ ଏହାକୁ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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270. To stop video time at 1 minute 47 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Text’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Text’ ଅପ୍ଶନ 

କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

271. To stop video time at 2 minute 17 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Crop picture’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Crop picture’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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272. To stop video time at 2 minute 40 seconds in VLC Media 

Player. 

 

Stop video here and ask students to open ‘Impress file’ and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ Impress file କୁ ଓମପନ କରିବା  

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

273. To stop video time at 3 minute 27 seconds in VLC Media 

Player. 

 

Stop video here and check whether they have opened ‘Impress file’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ମଚକ୍ କରିନିଅ ମସମାମନ Impress file କୁ ଓମପନ 

କରିସାରିଛନି୍ତ କି ନାହି ିଁ ? 

Now just check and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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274. To stop video time at 3 minute 47 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert four slides and type the given 

line on the 1st slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ 4 ଟି  ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ ପ୍ରଥମ ସ୍ାିଇଡ ମର ଦିଆଯାଇଥବିା ଱ାଇନ କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

275. To stop video time at 4 minute 01 seconds in VLC Media 

Player. 

 

Stop video here and ask students to draw any shape on the second slide 

and also ask to type a line about those Shapes and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଦି୍ଵ ୀୟ ସ୍ାିଇଡମର ମକୌଣସି shape  ିଆରି  

କରିବା ପାଇ ିଁ କୁହ ଏବଂ ମସହ ିshape ଗଡୁିକ ବିଷୟମର ମଗାଟିଏ ଱ାଇନ ଟାଇପ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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276. To stop video time at 5 minute 33 seconds in VLC Media 

Player. 

Stop video here and ask students to insert a picture as shown in the 

video and then play video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

ଚିତ୍ର ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

277. To stop video time at 6 minute 58 seconds in VLC Media 

Player. 

Stop video here and ask students to change the design of the slide as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ସ୍ାିଇଡ ର 

ଡିଜାଇନ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

278. To stop video time at 7 minute 56 seconds in VLC Media 

Player. 

Stop video here and ask students to change the design again as shown 

in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ପନୁବତାର  

ଡିଜାଇନ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

279. To stop video time at 8 minute 04 seconds in VLC Media 

Player. 

 

Stop video here and tell students if they know what work can do with 

help of the ‘Extension manager’ and how to use it? 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ 

‘Extension manager’ ଦ୍ଵାରା ମକଉ ିଁ କାମ କରାଯାଏ ଏବଂ ଏହାକୁ କିପରି ବୟବହାର 

କରାଯାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

280. To stop video time at 9 minute 07 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then 

click on ‘Extension manager’ as shown in the video and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Tools menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Extension manager’ କୁ କିି୍କ୍ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

281. To stop video time at 09 minute 53 seconds in VLC Media 

Player. 

Stop video here and ask students to download any extension as shown 

in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଯମକୌଣସି 

extension କୁ download କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

Note: - internet connection is required to download any contents. 

Note: - ମକୌଣସି contents କୁ download କରିବା ପାଇ ିଁ internet connection 

ଆବଶୟକ ।  

282. To stop video time at 15 minute 51 seconds in VLC Media 

Player. 

Stop video here and ask students to check the extension which they had 

installed and play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ extension କୁ check କରିବା ପାଇ ିଁ କୁହ 

ଯାହା ମସମାମନ install କରିଛନି୍ତ ଏବଂ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

Now just check and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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283. To stop video time at 16 minute 02 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Auto correct’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ  

‘Auto correct’ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

284. To stop video time at 16 minute 54 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then 

click on ‘Auto correct’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Tools menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Auto correct’ କୁ କିି୍କ୍ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

285. To stop video time at 20 minute 51 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used the ‘Auto correct option or not 

and then play the video again. 

 ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Auto correct’ ଅପ୍ଶନ ର ବୟବହାର କରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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286. To stop video time at 21 minute 00 seconds in VLC Media 

Player. 

 

Stop video here and ask them, if they know why we use ‘Customize’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ମସମାନଙୁ୍କ ପଚାର , ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ 

‘Customize’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

287. To stop video time at 21 minute 16 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have created the menu or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Menu’  ିଆରି କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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288. To stop video time at 27 minute 23 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why ‘Option’ option is used? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Option’ ଅପ୍ଶନ କାହି ିଁକି 

ବୟବହାର ମହାଇଥାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

289. To stop video time at 28 minute 01 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then 

click on ‘Option’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Tools menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Option’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

290. To stop video time at 29 minute 35 seconds in VLC Media 

Player. 

Stop video here and ask students to change the view of impress file as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି impress 

file ର  view  କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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291. To stop video time at 41 minute 46 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have used the ‘Option’ option and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Option’ କୁ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

292. To stop video time at 41 minute 53 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Interaction’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Interaction’ 

ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

293. To stop video time at 42 minute 51 seconds in VLC Media 

Player. 

Stop video here and ask students to type any word on the title box as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି title box 

ମର ମକୌଣସି word  ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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294. To stop video time at 45 minute 29 seconds in VLC Media 

Player. 

Stop video here and ask students to attach any document in title slide as 

shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି title slide  

ମର ମକୌଣସି document  କୁ ଱ଗାଇବା ପାଇ ିଁ କୁହ । 

Now just check and then play the video again . 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

295. To stop video time at 45 minute 38 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Slide transition’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Slide 

transition’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

296. To stop video time at 46 minute 05 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Tools menu’ and then 

click on ‘Slide transition’ as shown in the video and then play the video 

again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Tools menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Slide transition’ କୁ କିି୍କ୍ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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297. To stop video time at 48 minute 25 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have applied ‘Slide transition’ or not and 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Slide transition’  ଱ଗାଇଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

298. To stop video time at 48 minute 29 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Custom animation’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Custom 

animation’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

299. To stop video time at 49 minute 39 seconds in VLC Media 

Player. 

Stop video here and ask students to draw a smiley face as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

smiley face  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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300. To stop video time at 49 minute 38 seconds in VLC Media 

Player. 

Stop video here and ask students to draw an object as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

object  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

301. To stop video time at 50 minute 08 seconds in VLC Media 

Player. 

Stop video here and ask students to draw an object as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ମଗାଟିଏ 

object  ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

। 

302. To stop video time at 52 minute 45 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have customized the slides or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ସ୍ାିଇଡ ଗଡୁିକୁ customize କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

303. To stop video time at 52 minute 52 seconds in VLC Media 

Player. 
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Stop video here and ask students to close their file and shut down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office impress 2 Class 10 

Class 10 Summaries 

 

 How to record a data, picture and drawing in impress file? 

Impress file ମର ମଗାଟିଏ data, picture ଏବଂ drawing କୁ କିପରି record କରାଯାଏ ? 

 Why we use extension manager ? 

ଆମମ ‘Extension manager’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to use auto correct option ? 

‘Auto correct’ ଅପ୍ଶନ ମକମି ି ବୟବହାର କରାଯାଏ ? 

 What is rehearse timing ? 

Rehearse timing କଣ ? 

 Why we use interaction ? 

ଆମମ ‘Interaction’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to use slide transition ? 

‘slide transition’ ମକମି ି ବୟବହାର କରାଯାଏ ? 

 Why we use custom slide show ? 

ଆମମ ‘Custom slide show’ କାହି ିଁକି ବୟବହାର କରୁ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 
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304. To stop video time at 29 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell why we use spelling? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ spelling 

କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

305. To stop video time at 54 seconds in VLC Media Player. 

 

Stop video here and ask if they know why we ‘Custom Animation’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Custom 

Animation’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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306. To stop video time at 1 minute 23 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know what happens with ‘Customize’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ‘Customize’ ଦ୍ଵାରା 

କଣ ମହବ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

307. To stop video time at 1 minute 56 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Rehearse timing’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Rehearse 

timing’ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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308. To stop video time at 2 minute 17 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use interaction? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ Interaction 

କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

309. To stop video time at 2 minute 38 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know what is custom slide show? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ custom slide show 

କଣ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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310. To stop video time at 3 minute 03 seconds in VLC Media 

Player. 

 

Stop video here and ask students to turn on their computer and open 

‘Impress file’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର computer କୁ ON କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  Impress file କୁ ଓମପନ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

311. To stop video time at 3 minute 09 seconds in VLC Media 

Player. 

Stop video here and check whether they have opened the impress file or 

not and then play the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ମଚକ୍ କରିନିଅ ମସମାମନ Impress file କୁ ଓମପନ 

କରିସାରିଛନି୍ତ କି ନାହି ିଁ ? 

312. To stop video time at 3 minute 35 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert 5 new slides and type this 

paragraph about ‘Computer Shiksha’ and then play the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ 5 ଟି ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

‘Computer Shiksha’ ବିଷୟମର ଏହ ିପାରାଗ୍ରାଫ ଟି କୁ ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

313. To stop video time at 6 minute 12 seconds in VLC Media 

Player. 

Stop video here and ask students to insert picture and do formatting on 

this picture, after that they should practice ‘Custom animation’ option 

and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଚିତ୍ର ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ ମସହ ି

ଚିତ୍ର ମର formatting କରିବା ପାଇ ିଁ କୁହ,  ାପମର  ମସମାନଙୁ୍କ ‘Custom animation’ 

ଅପ୍ଶନ ର ଅଭୟାସ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

314. To stop video time at 7 minute 08 seconds in VLC Media 

Player. 

Stop video here and ask students to insert slides and draw shape using 

drawing toolbar as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ସ୍ାିଇଡ 

ଗଡୁିକୁ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ drawing toolbar କୁ ବୟବହାର କରି shape 

 ିଆରି କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

315. To stop video time at 10 minute 00 seconds in VLC Media 

Player. 

Stop video here and ask students to apply the Animation as shown in the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

Animation ଱ଗାଇବା ପାଇ ିଁ କୁହ ।  

 

316. To stop video time at 12 minute 38 seconds in VLC Media 

Player. 

Stop video here and ask students to use ‘custom animation’ and then 

show the slide show as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘custom 

animation’ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର slide show ମଦଖାଇବା ପାଇ ିଁ 

କୁହ  । 
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Now just check whether they have used ‘Custom animation’ or not and 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Custom animation’ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

317. To stop video time at 12 minute 47 seconds in VLC Media 

Player. 

 

Stop video here and ask students to open another file using ‘Interaction’ 

option and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Interaction’ ଅପ୍ଶନ ବୟବହାର କରି ଆଉ 

ମଗାଟିଏ ଫାଇ଱ କୁ ଓମପନ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

318. To stop video time at 15 minute 09 seconds in VLC Media 

Player. 

Stop video here and ask students to use ‘Interaction’ option as shown in 

the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

‘Interaction’ ଅପ୍ଶନ କୁ ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

Now just check whether they have used ‘Interaction’ option or not and 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Interaction’ ଅପ୍ଶନ କୁ ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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319. To stop video time at 15 minute 22 seconds in VLC Media 

Player. 

 

Stop video here and ask students to use the ‘Custom animation’ and 

then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Custom animation’ କୁ ବୟବହାର 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

320. To stop video time at 16 minute 25 seconds in VLC Media 

Player. 

Stop video here and ask students to select the paragraph and then click 

on the ‘Slide show’ menu and then click on the ‘Custom animation’ 

option as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

paragraph କୁ ସିମ଱କ୍ଟ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Slide show menu’ କୁ  କିି୍କ୍ 

କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Custom animation’ ଅପ୍ଶନ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

321. To stop video time at 19 minute 11 seconds in VLC Media 

Player. 

Stop video here and ask students to do the practice of ‘Custom 

animation’ on every slide as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ପ୍ର ୟକ 

ସ୍ାିଇଡ ମର ‘Custom animation’ ର ଅଭୟାସ କରିବା ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘custom animation’ option 

or not and play the video again for correct answer. 
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ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Custom animation’ ଅପ୍ଶନ ର ଅଭୟାସ କରିଛନି୍ତ 

କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

322. To stop video time at 19 minute 19 seconds in VLC Media 

Player. 

 

Stop video here and ask students to do practice of ‘Rehearse timing’ and 

then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Rehearse timing’ ର ଅଭୟାସ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

323. To stop video time at 21 minute 56 seconds in VLC Media 

Player. 

Stop video here and ask students to give the time for automatic slide 

show with time of every slide one by one using ‘rehearse timing’ as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

‘Rehearse timing’ ର ବୟବହାର କରି ପ୍ର ୟକ ସ୍ାିଇଡ ପାଇ ିଁ  time ମଦବାକୁ କୁହ  ାହାକୁ 

automatic slide କରିବା ପାଇ ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

324. To stop video time at 23 minute 16 seconds in VLC Media 

Player. 

Stop video here and ask students to apply ‘Rehearse timing’ as shown in 

the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

‘Rehearse timing’ ର ବୟବହାର କରିବା ପାଇ ିଁ କୁହ ।  
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Now just check whether they have used ‘Rehearse timing’ option or not 

and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Rehearse timing’ ଅପ୍ଶନ ର ବୟବହାର କରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

325. To stop video time at 23 minute 26 seconds in VLC Media 

Player. 

 

Stop video here and ask students to do practice of ‘Style and formatting 

option’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘Style 

and formatting’ ଅପ୍ଶନ ର ଅଭୟାସ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

326. To stop video time at 24 minute 48 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Format menu’ and then 

click on the ‘Style and Formatting’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘Format menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Style and Formatting’ କୁ 

କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

327. To stop video time at 25 minute 03 seconds in VLC Media 

Player. 

Stop video here and ask students to change the background color as 

shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

background color କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ।  
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Now just check whether they have practiced ‘Styles and formatting’ 

option or not and play the video again for correct answer. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Style and formatting’ ଅପ୍ଶନ ର ଅଭୟାସ 

କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

328. To stop video time at 25 minute 14 seconds in VLC Media 

Player. 

 

Stop video here and ask students to do the practice of ‘Slide Transition’ 

on every slide as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ପ୍ର ୟକ 

ସ୍ାିଇଡ ମର ‘Slide Transition’ ର ଅଭୟାସ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

329. To stop video time at 28 minute 04 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced ‘Slide Transition’ option or 

not and play the video again for correct answer. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Slide Transition’ ଅପ୍ଶନ ର ଅଭୟାସ କରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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330. To stop video time at 28 minute 14 seconds in VLC Media 

Player. 

 

Stop video here and ask students to give the effects using ‘slide 

transition’ and show slide show as shown in the video and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ‘slide 

transition’ କୁ ବୟବହାର କରି effects ମଦବା ପାଇ ିଁ କୁହ ଏବଂ slide show ମଦଖାଇବା 

ପାଇ ିଁ କୁହ  ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

331. To stop video time at 28 minute 57 seconds in VLC Media 

Player. 

Stop video here and ask students to apply the animation on the text and 

animation as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି text and 

animation ମର Animation ଱ଗାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 

332. To stop video time at 33 minute 06 seconds in VLC Media 

Player. 

Stop video here and ask students to apply the timing on each text and 

object as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ପ୍ର ୟକ 

text and object ମର timing ଱ଗାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର 

ଚ଱ାଅ । 
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333. To stop video time at 33 minute 44 seconds in VLC Media 

Player. 

Stop video here and ask students to play the slide show as shown in the 

video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି slide 

show କୁ ଚ଱ାଇବା ପାଇ ିଁ କୁହ । 

Now just check whether they have used ‘slide transition’ option or not 

and play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ slide transition’ ଅପ୍ଶନ କୁ ବୟବହାର କରିଛନି୍ତ କି 

ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

334. To stop video time at 37 minute 57 seconds in VLC Media 

Player. 

 

Stop video here and ask students to close their file and shut down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 
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Complete teacher’s manual for Open office Impress 2 Class 11 

Class 11 Summaries 

 

 Why we use ‘Interaction’ ? 

ଆମମ ‘Interaction’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Custom animation’ option? 

ଆମମ ‘Custom animation’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 Why we use ‘Color replacer’ option’? 

ଆମମ ‘Color replacer’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

 How to do any Formatting on drawing? 

Drawing ମର ମକୌଣସି Formatting କିପରି କରାଯାଏ ? 

 How to insert a new slide? 

ମଗାଟିଏ ନୂଆ slide କୁ କିପରି ଇନସଟତ କରାଯାଏ ? 

 How to convert slides into ‘Summary slide’?  

ସ୍ାିଇଡ ଗଡୁିକୁ ‘Summary slide’ ମର କିପରି ପରିବର୍ତ୍ତନ କରାଯାଏ ? 

 Why we use ‘Expand slide’? 

ଆମମ ‘Expand slide’ କାହି ିଁକି ବୟବହାର କରୁ ? 

 What happens by ‘Properties’ option? 

‘Properties’ ଅପ୍ଶନ ଦ୍ଵାରା କଣ ମହାଇଥାଏ ? 

 What happens by ‘Hyperlink’ option? 

‘Hyperlink’ ଅପ୍ଶନ ଦ୍ଵାରା କଣ ମହାଇଥାଏ ? 

 Why we use ‘Slide transition’? 

ଆମମ ‘Slide transition’ କାହି ିଁକି ବୟବହାର କରୁ ? 

Now let’s start the video. 

ଏମବ ଆସ  ଭିଡିଓ ଆରମ୍ଭ କରିବା । 
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335. To stop video time at 40 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell why we use ‘Interaction’ option’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ 

‘Interaction’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

336. To stop video time at 1 minute 04 seconds in VLC Media 

Player. 

 

Stop video here and ask if they know why we use ‘Slide transition’ 

option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ ଜାଣଛିନି୍ତ ଆମମ ‘Slide 

transition’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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337. To stop video time at 1 minute 36 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Minimize 

presentation’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Minimize 

presentation’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

338. To stop video time at 2 minute 11 seconds in VLC Media 

Player. 

 

Stop video here and ask if they can tell why we use ‘Slide design’ option? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ଆମମ ‘Slide 

design’ ଅପ୍ଶନ କାହି ିଁକି ବୟବହାର କରୁ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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339. To stop video time at 2 minute 34 seconds in VLC Media 

Player. 

 

Stop video here and ask students to open ‘Impress file’ and then play the 

video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ  ‘Impress file’ କୁ ଓମପନ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

340. To stop video time at 3 minute 39 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert four slides and also to change 

design of each slide and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ 4 ଟି ସ୍ାିଇଡ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

ପ୍ର ୟକ ସ୍ାିଇଡ ର design କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

341. To stop video time at 3 minute 45 seconds in VLC Media 

Player. 
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Stop video here and ask students to type about ‘Computer Shiksha’ or 

‘their own School’ and also to do formatting on the paragraph as 

explained in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Computer Shiksha’ କିମ୍ବା ମସମାନଙ୍କର 

ନିଜ School ବିଷୟମର ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ ଭିଡିଓ ମର ଜଣାଯାଇଥବିା ପରି 

paragraph ମର formatting କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ 

। 

342. To stop video time at 5 minute 04 seconds in VLC Media 

Player. 

Stop video here and ask students to change the formatting of any line as 

told in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ଜଣାଯାଇଥବିା ପରି ମଯମକୌଣସି 

଱ାଇନ ର  formatting ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର  

ଚ଱ାଅ । 

343. To stop video time at 8 minute 26 seconds in VLC Media 

Player. 

Stop video here and ask students to do the formatting on the line as 

shown in the video.  

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଱ାଇନ ମର 

formatting କରିବା ପାଇ ିଁ କୁହ ।  

Now just check whether they have done all these formatting or not and 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ଏହ ିସମସ୍ତ formatting କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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344. To stop video time at 8 minute 22 seconds in VLC Media 

Player. 

 

Stop video here and check whether they have completed the task or not 

and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ମଚକ୍ କରିନିଅ ମସମାମନ ଏହ ିସମସ୍ତ କାମ କରିସାରିଛନି୍ତ 

କି ନାହି ିଁ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

। 

345. To stop video time at 13 minute 36 seconds in VLC Media 

Player. 

Stop video here and ask students to apply the animation as shown in the 

video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି custom 

animation ଱ଗାଇବା ପାଇ ିଁ କୁହ ।  

Now just check whether they have applied ‘Custom animation’ or not 

and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Custom animation’ ଱ଗାଇଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

346. To stop video time at 14 minute 00 seconds in VLC Media 

Player. 
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Stop video here and ask students to insert any picture and change the 

background using the ‘Color replacer’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମକୌଣସି ଚିତ୍ର କୁ ଇନସଟତ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ ‘Color replacer’ ସାହାଯୟ ମର background କୁ ମଚଞ୍ଜ କରିବା ପାଇ ିଁ କୁହ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

347. To stop video time at 15 minute 43 seconds in VLC Media 

Player. 

Stop video here and ask students to replace the background color of the 

picture as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଚିତ୍ର ର 

background color କୁ replace କରିବା ପାଇ ିଁ କୁହ ।  

Now just check whether they have replaced the background color or not 

and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ background color କୁ replace କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

348. To stop video time at 15 minute 54 seconds in VLC Media 

Player. 
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Stop video here and ask students to do practice of ‘Slide transition’ and 

then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Slide transition’ ର ଅଭୟାସ କରିବା 

ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

349. To stop video time at 16 minute 57 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Slide show’ and then 

click on the ‘Slide transition’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Slide show’ ଉପମର  କ୍ିିକ୍ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ  ାପମର ‘Slide transition’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ 

ପନୁବତାର ଚ଱ାଅ । 

350. To stop video time at 19 minute 19 seconds in VLC Media 

Player. 

Stop video here and ask students to do slide show as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have applied the ‘Slide transition’ or not 

and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Slide transition’ କୁ  ବୟବହାର କରିଛନି୍ତ କି ନାହି ିଁ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

351. To stop video time at 19 minute 28 seconds in VLC Media 

Player. 
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Stop video here and ask students if they know what happens with 

‘Summary slide’? 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ପଚାର ଯଦି ମସମାମନ କହପିାରିମବ ‘Summary slide’ 

ଦ୍ଵାରା କଣ ମହାଇଥାଏ ? 

Just listen to the answers and play the video again for the correct 

answer. 

ଉର୍ତ୍ର ଶଣୁ ଏବଂ ସଠିକ୍ ଉର୍ତ୍ର ପାଇ ିଁ ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

352. To stop video time at 29 minute 17 seconds in VLC Media 

Player. 

Stop video here and ask students to type some title as shown in the 

video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କିଛି title 

ଟାଇପ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

353. To stop video time at 21 minute 45 seconds in VLC Media 

Player. 

Stop video here and ask students to create the Summary slide as shown 

in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି Summary 

slide  ିଆରି କରିବା ପାଇ ିଁ କୁହ ।  

Now just check whether they have created the summary slide or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ Summary slide  ିଆରି କରିସାରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

354. To stop video time at 21 minute 58 seconds in VLC Media 

Player. 
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Stop video here and ask students to convert ‘Summary slide into ‘Title 

slide’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ‘Summary slide’ କୁ ‘Title slide’ ମର 

ପରିବର୍ତ୍ତନ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

355. To stop video time at 22 minute 49 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

356. To stop video time at 21 minute 10 seconds in VLC Media 

Player. 

 

Stop video here and ask students to insert one more slide and in this 

slide ask them to attach any file on it as shown in video and then play 

the video again. 
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ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଆଉ 

ମଗାଟିଏ ସ୍ାିଇଡ କୁ ଇନସଟତ କରିବା ପାଇ ିଁ ମହବ ଏବଂ ମସହ ିସ୍ାିଇଡ ମର ମକୌଣସି ଫାଇ଱ କୁ 

attach କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

357. To stop video time at 21 minute 44 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘Hyperlink’ option as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି 

‘Hyperlink’ ଅପ୍ଶନ କୁ କ୍ିିକ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

358. To stop video time at 25 minute 19 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have inserted the ‘Hyperlink’ or not and 

then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Hyperlink’ ଇନସଟତ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ  ାପମର 

ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

359. To stop video time at 25 minute 29 seconds in VLC Media 

Player. 

 

Stop video here and ask students to convert their file into ‘MS Power 

point’ and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ‘MS Power 

point’ ପରିବର୍ତ୍ତନ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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360. To stop video time at 26 minute 10 seconds in VLC Media 

Player. 

Stop video here and ask students to click on the ‘File menu’ and then 

click on ‘Wizard’ as shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି  

‘File menu’ କୁ  କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ‘Wizard’ କୁ କିି୍କ୍ କରିବା ପାଇ ିଁ କୁହ 

ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

361. To stop video time at 27 minute 47 seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they converted the document or not and then 

play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ document କୁ ପରିବର୍ତ୍ତନ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

 

 

 

362. To stop video time at 26 minute 56 seconds in VLC Media 

Player. 

 

Stop video here and ask students to tell all information about the file as 

shown in the video and then play the video again. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି ଫାଇ଱ 

ବିଷୟମର ସମସ୍ତ ସଚୂନା ଜଣାଇବା ପାଇ ିଁ କୁହ ଏବଂ  ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 
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363. To stop video time at 29 minute 10  seconds in VLC Media 

Player. 

Stop video here and ask students to do as shown in the video. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ଭିଡିଓ ମର ମଦଖାଯାଇଥବିା ପରି କରିବା 

ପାଇ ିଁ କୁହ । 

Now just check whether they have practiced the ‘Property’ option or not 

and then play the video again. 

ଏମବ ଟିମକ ମଚକ୍ କରିନିଅ ମସମାମନ ‘Property’ ଅପ୍ଶନ ର ଅଭୟାସ କରିଛନି୍ତ କି ନାହି ିଁ ଏବଂ 

 ାପମର ଭିଡିଓ କୁ ପନୁବତାର ଚ଱ାଅ । 

364. To stop video time at 29 minute 22 seconds in VLC Media 

Player. 

 

Stop video here and ask students to close their file and shut down the 

computer. 

ଏହଠିାମର ଭିଡିଓ କୁ ବନ୍ଦ କର ଏବଂ ଛାତ୍ରମାନଙୁ୍କ ମସମାନଙ୍କର ଫାଇ଱ କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ 

କୁହ ଏବଂ କମ୍ପିଉଟର କୁ ବନ୍ଦ କରିବା ପାଇ ିଁ କୁହ । 

 


